Cube-3d

Logiciel 3D - Manuel utilisateur

Document source : Stonex Cube-3d User Manual, March 2026 - Ver. 4.0.1

Cube-3d

S

STONEX

3D Software

User Manual

© cube-3d

& STONEX

March 2026 - Ver.4.0.1 www.stonex.it

T=CH4 \yAPS

Cube-3d - Manuel utilisateur FR | Source Stonex User Manual Ver. 4.0.1



Sommaire

Section

1. Introduction au logiciel

1.1. Configuration systéme requise

1.2. Utilisation de la carte graphique

1.3. Modules Cube-3d

2. Présentation de l'interface graphique utilisateur

2.1. Ecran d’accueil

2.2. Visualiseur et fenétre de commande en direct

3. Préparation des données photogrammétriques (PH)

3.1. Paramétrage des options (PH, S)

3.2. Détails de licence (PH, S)

4. Traitement (PH)

4 1. Définition de la hauteur de vol

4.2. Mise en place des GCP

4.3. Chargement d'images avec métadonnées enregistrées

4.4. Ajustement de faisceaux

4.5. Orientation / géoréférencement

4.7. Reconstruction

5. Recalage de nuages de points (S)

6. Manipulation des nuages de points (PH, S)

7. Manipulation des maillages (PH, S)

8. Orthophoto numérique (PH, S)

9. Fonctions CAD (PH, S)

10. Présentation de projet (PH, S)

11. Rapports (PH, S)

12. Cloud (PH, S)

T=CH4 \yAPS

Cube-3d - Manuel utilisateur FR | Source Stonex User Manual Ver. 4.0.1



1. Introduction au logiciel

Cube-3d est une solution logicielle de cartographie et de traitement d'images aériennes. Elle permet de construire des
modeles 3D professionnels a partir d'images 2D et de données géospatiales acquises avec des drones ou d’autres
vecteurs et instruments.

Cube-3d propose a la fois un traitement photogrammeétrique - construction de la géométrie, géoréférencement et
reconstruction dense - ainsi que des fonctions de modélisation et d’analyse 3D sur les nuages de points générés dans
Cube-3d ou provenant de sources tierces : LAS, LiDAR, CAD, etc.

Le logiciel permet de créer des orthophotos numériques, des modéles numériques de surface, de calculer des volumes et
de gérer des stocks de matériaux rapidement. Un assistant de rapports intégré aide a regrouper les résultats dans un
document compact et présentable.

Les données accessibles et le flux de travail varient selon le projet. Les deux cas d’usage les plus fréquents sont décrits ci-
dessous.

Cas d’usage 1 - Vol drone + traitement Cube-3d + modélisation/analyse

L'utilisateur capture ses propres images, avec les données EXIF, GNSS, GPS RTK ou équivalentes nécessaires au
géoréférencement, puis les importe dans Cube-3d pour le traitement photogrammeétrique. 1l définit ensuite les paramétres
d’ajustement de faisceaux, d’orientation et de reconstruction. Le résultat est un nuage de points 3D métrique, géoréférencé
et colorisé de maniére réaliste, utilisé comme base pour les calculs, la modélisation et I'analyse.

Cas d’usage 2 - Modélisation et analyse Cube-3d

Lorsque le traitement photogrammétrique n’est pas nécessaire, I'utilisateur peut importer des données tierces : nuages
LAS, nuages photogrammeétriques issus d’autres logiciels, données LiDAR, etc. Cette partie permet de construire,
manipuler et personnaliser des nuages de points, DSM, DEM et orthophotos, de calculer des volumes, profils et courbes
de niveau, de générer des rapports et d’exporter les données vers des formats CAD ou autres.

Ce manuel vise a aider I'utilisateur a exploiter Cube-3d pour obtenir des résultats professionnels a haute précision. Le
logiciel prend également en charge des données acquises avec des méthodes de mesure classiques.

1.1. Configuration systeme requise

Cube-3d fonctionne sous Windows 64 bits. Le traitement est exécuté par le processeur, tandis que l'interface graphique
s’appuie sur le GPU. Pour de bonnes performances, il est recommandé de disposer d’au moins 16 Go de RAM.

Profil Configuration

Minimum Windows 7, 8 ou 10 64 bits ; Intel i5 ou Ryzen 5 ; 16 Go
RAM ; NVIDIA GTX 1050 ou mieux ; SSD 128 Go +
HDD 500 Go.

Recommandé Windows 11 64 bits ; Intel i7 ou Ryzen 7 ; 32 a 64 Go
RAM ; NVIDIA RTX 5060 Ti 16 Go ; SSD NVMe 2 To.

Professionnel Windows 11 64 bits ; Intel i9 ou Ryzen 9 ; 64 a 128 Go
RAM ; 2 x NVIDIA RTX 5060 Ti 16 Go ; SSD NVMe 4
To.

Avertissement : les processeurs Intel Core 13e et 14e générations en versions K/KF/KS présentent des problémes
d’instabilité connus ; ils ne sont pas recommandés pour cet usage.
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1.2. Utilisation de la carte graphique
Sur un ordinateur portable, le mode d’alimentation doit étre réglé sur hautes performances.

En présence d’une carte graphique dédiée, il est recommandé de forcer I'utilisation de cette carte par Cube-3d.

Procédure : clic droit sur le raccourci Cube-3d -> Exécuter avec le processeur graphique -> Modifier le processeur
graphique par défaut. Dans le panneau de contréle de la carte, ouvrir Gérer les paramétres 3D -> Paramétres de
programme. Vérifier que Cube-3d figure dans la liste ; sinon, cliquer sur Ajouter, sélectionner Cube-3d, puis valider.

S

STONEX

When card's control panel pops up, go to Manage 3D settings -> Program settings. Check if Cube-3d is on the list of
selected Program to customise. If not, click Add button and find Cube-3d. Click Add Selected Program and close Control
panel.
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1.3. Cube-3d modules

Several modules of Cube-3d are available, subdivided as follows:

Tool PHOTO SCANNER PRO
3D Model from images/video N v
GCP Orientation N v
Classification v v v
Point Cloud Registration s o
Mesh Calculation Vv v v
Ortophota o s
2Dviews Generation W v
CAD b v v
Volume Calculation N Vv v

Stonex Cube-3d - User Manual &
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1.3. Modules Cube-3d

Cube-3d est disponible en plusieurs modules : PHOTO, SCANNER et PRO. Les fonctions décrites dans le manuel sont
toutes disponibles dans la version PRO. Chaque section indique les modules concernés par la fonction.

Fonction PHOTO SCANNER PRO
Modele 3D a partir Oui Oui
d’images/vidéo

Orientation par GCP Oui Oui
Classification Oui Oui Oui
Recalage de nuages de Oui Oui
points

Calcul de maillage Oui Qui Oui
Orthophoto Oui Oui Oui
Génération de vues 2D Oui Oui
CAD Oui Qui Oui
Calcul de volumes Oui Oui Oui
Calcul de profils Oui Qui Oui
Courbes de niveau Oui Oui Oui
Enregistrement vidéo Oui Oui Oui

Le module PHOTO permet de traiter complétement des données photogrammeétriques, depuis les images jusqu’au modéle
3D complet avec analyse. Le module SCANNER est congu pour importer, recaler et analyser des nuages de points issus
de scanners laser.

Légende : PH = module PHOTO ; S = module SCANNER.

T=CH4 \yAPS

Cube-3d - Manuel utilisateur FR | Source Stonex User Manual Ver. 4.0.1



2. Présentation de l'interface graphique utilisateur

2.1. Ecran d’accueil

A l'ouverture de Cube-3d, I'utilisateur arrive sur un écran d’accueil proposant plusieurs options : créer un nouveau projet,
ouvrir un projet existant ou sélectionner un projet récent. Les autres boutons restent désactivés tant qu’aucune donnée
n’est chargée dans I'application.

L’interface graphique de Cube-3d comprend quatre zones fondamentales regroupant les outils, options avancées,
indications et informations nécessaires au traitement des données :

1.

2.

Barre d’outils : zone supérieure gauche donnant accés aux principales fonctions.

Panneau de travail : situé a droite, il contient sept onglets. Chaque onglet donne accés aux outils de base et avancés
liés a I'étape en cours. Les onglets se débloquent progressivement selon 'avancement du flux de traitement.

Fenétre de commande en direct : située en bas a gauche, elle affiche les résultats instantanés des fonctions en cours :
coordonnées du curseur, distances calculées, etc.

Visualiseur : zone centrale utilisée pour afficher les images, données 2D et données 3D.
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2. GUI (Graphical User Interface) walkthrough

7 i Welcome screen

Opening Cube-3d brings us to a welcome screen with a couple of options to start our project; New project, Open an
existing project, or select from recent projects list. Other buttons remain disabled as no data is loaded in the app.

New project Open project

Graphical user interface of Cube-3d consists of four fundamental sections with tools, advanced options, guidelines and
information for data processing:

1. Toolbar is the upper left part that provides us with all main options

2. Working Panel is located on the right side containing seven tabs, each giving us basic and advanced tab related
tools. Tabs unlock as we move through processing to point cloud, modelling, Orthophoto, etc. Some menus, as
well as some functions are locked due to either lack of data or because we tried to skip some of the processes.

3. Live Command Window is located on the lower left part, providing us with live results of running functions:
coordinates of marker's position, computed distances, etc.

4. Viewer is the central board for viewing images, and all of 2D or 3D data.

2.2. Viewer and live command window

Main Viewer screen and Live Command line provide and interactive graphical and numerical interfaces for you to control
and work with models, results, pick points, monitor coordinates as you explore your 2D or 3D material. The easiest way to
handle models in Cube-3d is using a mouse and its four operations. Left mouse click is, just like any other app, used for
selecting (starting polygon selection). When selecting polygon, use left mouse button to determine its points and right
mouse click to finish your selection. To rotate models, click and hold left mouse button. To zoom in or out use the scroll
wheel. If you need to shift the selected angle of view at selected zoom, click scroller and use it like pan function. When
viewing Orthophotos or Profiles use scroller to zoom and pan.

Stonex Cube-3d - User Manual &
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2.2. Visualiseur et fenétre de commande en direct

Le visualiseur principal et la fenétre de commande en direct fournissent une interface graphique et numérique interactive.
lls permettent de contréler les modéles, consulter les résultats, sélectionner des points et suivre les coordonnées lors de
I'exploration des données 2D ou 3D.

La maniére la plus simple de manipuler les modéles dans Cube-3d consiste a utiliser la souris. Le clic gauche sert a
sélectionner ou a démarrer une sélection polygonale. Lors d’une sélection par polygone, les sommets sont définis avec le
bouton gauche et la sélection se termine avec un clic droit.

Pour faire pivoter les modéles, maintenir le bouton gauche de la souris enfoncé. Pour zoomer, utiliser la molette. Pour
déplacer la vue a un niveau de zoom donné, cliquer sur la molette et I'utiliser comme fonction panoramique. Dans les
orthophotos et les profils, la molette sert au zoom et au déplacement.

S
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3D Rotate Scroll Wheel to Pan Confirming
Vertical Zoom in or Out Function Closing
Navigation selection

Stonex Cube-3d - User Manual 9
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3. Préparation des données photogrammeétriques (PH)

Préparer le dossier du projet sur le disque, puis copier dans ce dossier les images du projet depuis la carte SD. Si le drone
ou le vecteur utilisé prend en charge la télémétrie, ces données doivent étre conservées et importées avec les images.

Selon le modéle de drone, les données de télémétrie peuvent étre directement inscrites dans les métadonnées des images
ou enregistrées dans un fichier séparé au format CSV.

Le fichier CSV doit étre placé avec les images. Il peut contenir les champs suivants : état d’activation, index, longitude,
latitude, altitude, date, heure, lacet, tangage, roulis, précision X, précision Y, précision Z, précision angulaire, flou et nom
de fichier.

Il est recommandé d’enregistrer également le fichier des points de contréle au sol, ou GCP, dans le méme dossier que les
images. Le fichier GCP doit étre structuré de maniére simple : nom du point, coordonnée X, coordonnée Y, coordonnée Z,
séparés par des espaces.

Pour les grands jeux de données, il est fortement conseillé de réaliser et d’archiver un plan de localisation des GCP et des
points de validation. Cette précaution évite les ambiguités lors de I'orientation ou lors d’une reprise de projet.
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3. Preparation of photogrammetric data (PH)

Prepare your project folder on your disk and copy your images of selected project from SD card into the folder. If your UAV
supports telemetry, use that data. Depending on your UAV model, telemetry data are ascribed to images, or recorded into
*.csv file.

The .csv file must also be added alongside images and consists of further data: enabled, index, longitude, latitude, altitude,
date, time, yaw, pitch, roll, x Sigma, y Sigma, z Sigma, p Sigma, blur, and file name. Organization of data must be known
but is to be specified as you wish. See below an example of generic telemetry file (use this option if your UAV type is not
listed). It is recommended you save your ground control peint coordinates (GCPs) .t file into the same folder as your
image files. GCP file should be organized in the following way: point name, x coordinate, y coordinate, z coordinate — space
delimited. Be advised, it is highly recommended to make some map of GCP/validation points locations especially when
large datasets are in use.

Example of GCP coordinate file:

2000 461826, 101890.277  299.055
2002 461850 .87 101944.218 I06.204
2003 461912.47 101575.102  298.454
2004 461518. 102038.315  25B.804
2005 461524.7 102083.946  256.882
2006 461869 .2° 10202%.085  257.432
2007 461862.2 1015990.371 294.737
2008 46186 102042.424  294.880
2009 461828.060 102028.207  300.632
2010 461796. 101953.8668  299.834

Example of csv telemetry file:

Bty A e,

VORISR0, 0445, 12 015013 0m,_ 700D S 00MSDCF L8000 15

565,15, 12 2115\ L30m, A DORASDOMSDCF DSC000L 96

D514 0 _TONDCIM LN DCF| DECD006S. 1PG

\OMRDCF LA CI8004 PG

VO D DAL D000 1P

A20m_TONDCINA L0V DCF| DSCD0006 1PE

L0780 XM, BOEA S F DECO0007. 5

£.005# 15 43 30851 30m 01 M\ BORDCH SR CIN0R 100

Stonex Cube-3d - User Manual 10

Page source 10 - exemples de fichiers GCP et de télémétrie CSV.

3.1. Paramétrage des options (PH, S)

Démarrer Cube-3d puis définir la langue de l'interface. Ouvrir Options -> Application settings, puis sélectionner la langue et
les unités. Le redémarrage de I'application est nécessaire pour appliquer ces changements.

L’option Automatic machine deactivation désactive automatiquement la machine a la fermeture du logiciel. Cela permet
d’utiliser ensuite la méme licence sur un autre ordinateur sans devoir retirer manuellement la licence de la premiére
machine.

Il est possible de définir le nombre de décimales affichées dans les mesures CAD, jusqu’a un maximum de 5.
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Lorsque les unités impériales sont sélectionnées, il faut choisir entre International foot et US survey foot. L’option Other
permet de saisir manuellement la valeur d’'une unité en métres, par défaut 1.000000000000.

STONEX

Example of .csv generic telemetry log file:

Standard log fike for telemetry import.

File type: *.cwv
Defimiter: semicolon [;]

frege ramenss]  [Tongaude! [Latitude [ide] [aw] [Pech Roll_
DSCO17620PG | 34841008 119183754 e H " % S s 162
DSCOI76309G  ;  JAsa1n 119183754 29 Pl ER H 108
DSCM 76406 i 34 BA0RRY 119083762 730 3 1775 in 162
DSCO1765JPG  , 34.840485 119.183754 | 230 H 284 ; 321 : 174
DSCO1T660PG ;34840088 | 119183762 29 ;e in H 14
DSCNTET NG IARWIGT? 11918754 m i 1Sy n 180
DSCOI7R8PG | JARM2YS 119183762 m pomsss m 1
DSCO17600PG  ;  JasBEsr | 10800 ti oA ;A am
OSCOI7700PG ;M R3B463 119183762 2% P INeS in ¥ 1568
OSCO17710RG ;| 34 838066 119.183762 29 : 16639 i 3 174
DSCO17720PG ;3483765 usaeve | 230 E 66 ; 33 18
DSCOL773PG  ; JABI2SA 119183789 229 ;190 LRy 185
DSCIT7APG | VARMRM ARLALAN L) m R L2 . B 10 125
DSCM77SPG  ©  JARIGAYY | 119183769 0 i 15748 EE 1 H 185
OSCO17760PG ;3483604 119.183769 : 230 ; 15743 ; AW ass
DSCNTT7RG ;  JARISEXS 119.183765 230 ; 15788 37 [ 185
OSCO1T78UPG ;34835228 119183777 230 i 15748 ;3% 185
DM ITPG i MARMR2 19187 o H 164 ww H 185
DSCOI7R0UPG | 34841 119183760 pr ] LooAssas 32, s
DSCOI78IIPG ;34838019 | 119183777 o ;15499 LR : 155
DSCM TR PG i JARIIGIA 1191837717 730 F 15507 337 H 180
3:1 Option settings (PH, S)

Start Cube-3d and set language. Click Options -> Application settings and select language and units- You have to restart
application to assign applied changes. If select Automatic machine deactivation, after closing the software the machine
will be automatically deactivated, letting the user to use the software a second computer without removing the license
manually.

You can also set the number of decimal places shown in CAD measurements, up to a maximum of 5.

" Application Settings X

When impenial units are selected, you can further assign weather you want International foot or US survey foot You can
select Other. On the right, where by default is set 1.000000000000, type value of Tunit in meters.

Next, click Bundle Adjustment.
Stonex Cube-3d - User Manual 11

Page source 11 - parametres généraux, langue, unités et décimales CAD.

Réglages Bundle Adjustment

L’onglet Bundle Adjustment permet de définir le nombre maximal de threads paralléles. Par défaut, Cube-3d détecte les
threads disponibles et les utilise tous. Il peut étre pertinent de diminuer ce nombre lorsque la RAM est limitée, afin de
réduire le risque de plantage ou de fuite mémoire pendant le traitement.
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Exemple : avec un processeur i7 a 4 coeurs / 8 threads mais seulement 8 Go de RAM, il est conseillé de limiter le
traitement a 4 threads.

Maximum detected features correspond au nombre maximal de points caractéristiques détectés sur les images. La valeur
par défaut est 40 000. Ces points servent de points homologues pour relier les images entre elles et constituer le bloc
photogrammeétrique.

Feature detection level définit la robustesse de la phase d’appariement. Plus le niveau est élevé, plus le calcul est long.
Les niveaux disponibles sont Normal, High et Ultra.

Réglages Reconstruction

L’onglet Reconstruction permet de définir le nombre maximal de threads paralléles pour cette étape. La valeur par défaut
est 8. Une fois les valeurs souhaitées définies, cliquer sur OK pour les appliquer. Les réglages Bundle Adjustment et
Reconstruction ne nécessitent pas le redémarrage de I'application.
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¢ Application Settings X

There you can assign:

Mumber of Maximum parallel threads depend on your computer CPU type. For default value Cube-3d checks number of
available threads and directs them all. Decreasing threads is an option when RAM is insufficient to avoid plausible comp
crash. It is imperative to keep sufficient level of RAM and processor. For example: if you have a good i7 processor with 4
cores - 8 threads and just 8GB of RAM we would advise you to lower the threads number to 4. This will aveid memaory leaks
during the processing.

Number of Maximum detected features, default number is 40.000;
Features correspond to so called tie points on each image further used for “sawing” them to strings and strings to block.

Feature detection level defines robustness of the matching step. Level of detection is inversely proportional to reliability
and smoothness of detected points - features. Level of detection is also proportional to time of computation. Levels rise
from Normal, High to Ultra.

Click Reconstruction to set Number of maximum parallel threads, where default value is 8. When all preferred values
are assigned, click Ok to assign selected measures.

" Application Settings e

To save the changes for Language and Units you have to restart application to assign applied changes.

Stonex Cube-3d - User Manual 12

Page source 12 - réglages Bundle Adjustment et Reconstruction.

3.2. Détails de licence (PH, S)

Toutes les licences Cube-3d sont des licences flottantes. Pour libérer une licence, ouvrir Help -> License puis cliquer sur
Deactivate machine.

Cette opération permet d'utiliser la méme licence sur un autre poste. La fenétre de licence permet également de vérifier les
modules actifs.

En cas de nouveau code de licence, cliquer sur Change license key.
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4. Traitement (PH)

Aérotriangulation, géoréférencement et reconstruction

Cette partie de Cube-3d permet d’importer des jeux de données contenant des images et des informations géospatiales
afin de générer des nuages de points métriques et géoréférencés. Ces nuages servent ensuite de base aux opérations de
modélisation et d’analyse.

Lorsqu’un drone ou un aéronef est utilisé, les données exploitées sont des images aériennes avec recouvrement,
accompagneées de positions image issues de 'EXIF, du GPS, du RTK, du PPK ou de points de contrdle au sol.

Il est recommandé d'utiliser un logiciel ou une application de planification de mission compatible avec le drone. La
trajectoire de vol doit garantir un recouvrement suffisant des images, condition indispensable pour I'appariement et
I'alignement. Le recouvrement conseillé est de 70 % minimum ; sur les terrains a fort relief, il est préférable de monter
jusqu’a 80 %.

| Flux de base : placer les GCP -> planifier la mission et réaliser le vol -> importer les images et positions dans Cube-3d.

4.1. Définition de la hauteur de vol

La qualité du résultat dépend fortement des parameétres définis des le départ. Un recouvrement plus élevé génére plus
d’'images, donc un temps de traitement plus long. Le recouvrement minimal entre images est de 65 % en longitudinal et en
latéral. Dans les cas défavorables - caméra grand angle, végétation haute, terrain irrégulier - il est plus prudent de viser 80
%.

La hauteur de vol dépend de la taille de pixel terrain souhaitée, de la résolution de la caméra et des caractéristiques du
terrain. Si la plateforme fournit une télémétrie fiable, ces informations doivent étre exploitées.

Réglages standard recommandés

e Angle caméra nadiral, vertical vers le sol : 90°.
e Hauteur de vol : 40 a 150 m AGL, généralement autour de 80 m.
e Recouvrement longitudinal : 80 %. Recouvrement latéral : 75 %.

La plupart des drones géotaggent automatiquement les images a partir du GPS embarqué, avec une précision typique de
I'ordre de 1,5 m. Le modéle peut étre orienté dans Cube-3d a partir de cette télémétrie. Pour obtenir une précision
topographique, jusqu’a environ 4 cm, il faut installer des GCP avant le vol et les mesurer avec un récepteur GNSS RTK de
qualité topographique.

Avec un drone équipé d’'un GPS RTK centimétrique, les données RTK peuvent orienter correctement le modéle sans GCP.
Toutefois, lorsque le terrain le permet, I'utilisation de GCP reste recommandée.

Conseils terrain

Démarrer la mission depuis le point le plus haut par rapport au terrain cartographié. De nombreux drones réalisent la
mission dans un plan unique sans adapter automatiquement leur hauteur au relief. Un départ depuis une zone basse peut
conduire a un recouvrement insuffisant sur les points hauts, batiments ou arbres.

Une hauteur de vol plus basse et une meilleure résolution GSD ne donnent pas toujours de meilleurs résultats. En zone
dense, les batiments élevés peuvent mal se projeter dans I'orthophoto et les raccords d'images peuvent étre imparfaits si
les vues sont prises directement au-dessus des toitures.

Pour améliorer le raccord au-dessus des batiments, il est conseillé de réaliser une mission a 80 m AGL, puis de déclencher
manuellement quelques images nadirales a plus haute altitude, par exemple 120 m au-dessus de I'objet, afin que le
batiment complet apparaisse dans une seule image.
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the terrain characteristics. This can result in an insufficient image overlap (less then 60%) when capturing higher
terrain points, high buildings, high trees, etc. in case you start the mission from lower positions.

a. Best practice: Drone mission 80m 80% overlap 65m 70% overlap 95m 90% overlap

fﬂ’ - - Drone mission

65m
70% overlap
95m
90% overlap
.\‘ W—— 7
b. Wrong starting point:
Drone mission ‘H’
asm
50% overlap
80m
BO% overlap
T SRR, —

2. Lower flying height with better ground pixel resolution (GSD) does not always mean better results. In areas with
high density of buildings, flying too low can result in the following:

a. High buildings will not be ortho-projected in the digital orthophoto.

80 m AGL - Phantom 4 PRD

b. Image stitching can be less than perfect if they are directly over a building.
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Page source 15 - incidence du point de départ, du relief et de la hauteur de vol sur le recouvrement.
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To eliminate the over-the-building image stitching we advise you to have the whole building on a single image. First,
perform your mission at 80 m AGL, then manually trigger a few nadir images from a higher AGL (120 m above the object,
for example) to get the whole object in one image. That enables you to recalculate the area with - or/and around - the
building.

4.2. GCP setting up

Ground control points orientate the model and improve the accuracy of calculated model. Minimum
required number of GCPs to orientate the model is 3, however it is highly recommended you always use
more than required. We advise you to set up a minimum of 10 GCPs per 10 acres (most common area size
that can be mapped with a Drone on a single battery).

Use recognised targets (1. Stonex AutoDetect Target, 2. Checkbox Target, 3. AprilTags, 4. Custom) as GCPs,
place them on the ground before flight and measure them with a GPS (GNSS) or total station.

Use the advanced automatic orientation in Cube-3d.

Stonex Cube-3d - User Manual 16

Page source 16 - exemple de recalcul autour d’un batiment et types de cibles GCP.

4.2. Mise en place des GCP

Les points de contréle au sol, ou GCP, servent a orienter le modéle et a améliorer la précision du résultat final. Le nombre
minimal requis pour orienter un modéle est de 3, mais il est fortement recommandé d’en utiliser davantage.

La recommandation pratique est d’utiliser au minimum 10 GCP pour 10 acres, surface fréquemment couverte par un vol
drone sur une batterie.

Les GCP peuvent étre matérialisés par des cibles reconnues : Stonex AutoDetect Target, cible damier, AprilTags ou cibles
personnalisées. Elles sont placées au sol avant le vol puis mesurées avec un GNSS ou une station totale.
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Si les cibles Cube-3d ne sont pas utilisées, des points caractéristiques peuvent étre mesurés : plaques d’égout, bordures,
marquages routiers, angles de batiment, etc. L’orientation reste possible dans Cube-3d, mais elle sera généralement semi-
automatique.

Facteurs influengant la précision finale

e Type de caméra.

e Hauteur de vol et résolution image.

¢ Nombre de GCP et qualité de leur répartition.

Bonnes pratiques de répartition

Sur une zone carrée ou compacte, les GCP doivent étre répartis uniformément sur toute la zone et ne pas étre placés trop
prés de la limite extérieure.

Sur terrain irrégulier ou accidentg, il est fortement conseillé de placer des GCP aux points bas et aux points hauts de la
zone.

Pour atteindre une précision topographique, placer les GCP a 50 - 100 m les uns des autres. Une densité supérieure de
GCP améliore généralement la précision finale.

Pour un linéaire de route, voie ferrée ou berge, placer les GCP par paires tous les 50 a 100 m : un point de chaque cété de
I'objet d’intérét. Cela stabilise la précision sur 'ensemble du linéaire.
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Note: in case you are not using Cube-3d ground control target template you can measure any characteristic
point in the area of interest, such as manholes, curbs, road markings, etc. That still enables you to do the
orientation in Cube-3d but in this case semi-automatic.

Accuracy of the end model depends on:

e Camera type
e Flying height (image resolution)
e Number of GCPs and correct setup

Best practice GCP setup

Square areas GCPs should be spread across the whole area as uniformly as possible and should not be
placed to close to the border of the area of interest.

(=%,

In case of uneven (or rugged) terrain it is highly recommended to place GCPs on both lowest and highest
points of your area of interest.
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Page source 17 - exemple de répartition de GCP sur une zone étendue.
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To achieve survey-grade accuracy, place your GCPs 50-100 m apart. Higher density of GCPs also means
higher accuracy of end results.

Road/Railway example of GCP setup

To achieve survey-grade accuracy (up to 4 cm) we advise to set up GCPS in pairs every 50 — 100 m - one to
the left and one to the right of the object of interest (road, railway, river bank, etc). This will provide you
with a stable and consistent accuracy across the whole area — around the pairs as well as between them.

Stonex Cube-3d - User Manual 18

Page source 18 - densité recommandée et exemple route/voie ferrée.

4.3. Chargement d’images avec métadonnées enregistrées (PH)

Démarrer Cube-3d, cliquer sur New project dans le visualiseur et sélectionner les images du projet dans leur dossier. La
méme opération peut étre réalisée depuis la barre d’outils : Images -> Load images.

Une fois les images chargées, la fenétre d’'import de télémétrie apparait. Pour les drones DJI, Yuneec et tous les drones
enregistrant la position GPS dans les images, utiliser les données EXIF.

Pour les drones avec fichier de log séparé, choisir 'une des options proposées : C-Astral Bramor en CSV, MaVinci Sirius
Pro en CSV, données EXIF type DJI Phantom 4/Inspire 1/eBee/Falcon 8, ou Other en CSV pour les cas génériques.
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Aprées import, Cube-3d lit la télémétrie et ouvre une fenétre permettant de définir le systéme de coordonnées des images et

celui du projet. Si les images contiennent déja ces informations, le logiciel les lit automatiquement ; sinon, elles peuvent
étre définies manuellement.

L’utilisateur peut sélectionner le systéme horizontal, le systéme vertical et préciser si la hauteur est ellipsoidale ou
géodésique. Des préréglages déja créés peuvent également étre sélectionnés.

S

STONEX
4.3. Uploading images with saved metadata (PH)

Start Cube-3d, select the button New project in the Viewer and select the project images in the folder. The same can be
done via the Toolbar Images - > Load images.

i 1 G

PIRMIR S WK k] e
|

When images are uploaded, the telemetry importer window appears. For DJI drones, Yuneec drones and all other drones
that write the GPS position of the images during flight use EXIF data.

For drones with a separate log file, use one of the following options:
e  C-astral Bramor - *.csv
e MaVinci Sirius Pro = *.csv dati Exif (DJI Phantom 4, Inspire 1, eBee, Falcon 8,.)

e Other > *.csv

When images are imported, their telemetry is read. This opens a page where you enter the coordinate system of the images
and the project. If the images already have this information the software reads it automatically, otherwise you can set it
manually. You can select the horizontal coordinate system, and also the vertical coordinate system. Then select whether
the height is ellipsoid or geodetic.

It is also possible to select previously created presets, changing from Custom to another system.
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Page source 19 - chargement des images et choix de la source de télémétrie.
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La fenétre Telemetry présente les données importées, leur transformation dans le systéme de coordonnées du projet et

leur précision. L'utilisateur peut modifier manuellement la précision, définir le décalage Camera to GCP offset et la hauteur
de vol. En cas de mauvais fichier log, utiliser Reimport pour réimporter les données.
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h - ELIPSOIDE height
N - ORTOMETRIC height
H - GEOID HEIGHT

Ieiemerry Importer

The telemetry will be read in automatically and a new window will open. The Telemetry window will open, presenting the
imported data and their transformation into the project’s coordinate system with their accuracy. You can manually set the
accuracy and determine the Camera to GCP offset and Flight Height. If you imported the wrong log file, click on

Reimport, to re-import the telemetry data or/and close. Camera positions are displayed in the Viewer after the data has
been imported and processed.
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Page source 20 - sélection des systemes de coordonnées et apercu télémeétrie.

4.3.1. Chargement d’images avec télémétrie externe (PH)

Si les images importées ne contiennent pas de valeurs de télémétrie dans leurs métadonnées, un fichier externe peut étre
chargé. Cliquer sur I'icbne crayon pour ouvrir I'interface d'import.
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Définir d’abord le séparateur de données. Cliquer sur Semi-column [;] ou sur le séparateur affiché, puis choisir le caractere
correspondant au fichier. Il faut ensuite associer les colonnes du fichier log aux attributs attendus par le logiciel.

Cliquer sur I'en-téte de chaque colonne affichant none, puis sélectionner dans la liste 'attribut correspondant : nom
d’'image, longitude, latitude, altitude, yaw, pitch, roll, etc.
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4.3.1. Uploading images with external telemetry (PH)

If the images you upload do not have telemetry values saved in the metadata, you can upload an external file with this
information. Select the pen icon.

Telarmtry Imparter

First set the data delimiter. Click where Semi-column [}] is displayed and select the delimiter sign. Mow you have to assign
the attributes of your log file to each column. Click on a tab at the top of each column, where none is displayed. Scroll
down the list and click on the desired attribute to assign each column to the specified attribute.
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Page source 21 - attribution des colonnes de télémétrie externe.

Aprés cette étape, sélectionner les systémes de coordonnées des images et du projet. Pour rechercher un systéme de
référence ou un géoide, cliquer sur le nom du datum et saisir le nom ou les mots-clés de recherche. Une fois toutes les
informations sélectionnées, cliquer sur Import.
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Tetemetry mpecter

See below for an example of what the file should look like to import telemetry data.

Standard log the for telemetry impon.
File type: *.cov
Desimiter: semicolon |
e = tangRinde Lottude PR 2 ach Boil
DSC01TE2.P6 38341688 230 46,75 e 62
OKO1630G 3481301 2 16275 33 e
DSC01 764,196 14 RAORR1 %0 17756 13 "
LS01765.1P6 34340485 30 1854 i3 "
34840088 29 19207 a3 7
14 90872 % 19051 x ”
1m0 " freen) 187 +
s 30 mn 23 0
4838463 % 17285 33 8
34330065 » 16639 13 "
] 30 1616 i 85
837254 % 15801 33 ¥
34 m6R38 30 15279 10 &
34836437 2 15745 33 &
3683608 ™ 15743 iy 8
34835605 20 5788 13 A
3438228 2 15748 a7 85
a3 w0 15664 1y n
sam30s s 5525 137 2
3834019 % 15499 33 8
W EIWIR 0 15507 v 10

Itis then possible to select the coordinate systems of the images and the project. To search for the desired reference system
or geoid, click on the datum name and type in the name or keywords for the search. Once all the data have been selected,
click on Import.

The telemetry will be read in automatically and a new window will open. The Telemetry window will open, presenting the
imported data and their transformation into the project’s coordinate system with their accuracy. You can manually set the
accuracy and determine the Camera to GCP offset and Flight Height. If you imported the wrong log file, click on
Reimport, to re-import the telemetry data or/and close. Camera positions are displayed in the Viewer after the data has
been imported and processed.
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Page source 22 - import du fichier externe et sélection du systeme de coordonnées.

4.3.2. Commandes pour les images (PH)

En haut a gauche du visualiseur, quatre boutons permettent de choisir le mode d’affichage : Images, Maps, Telemetry et
Sparse point cloud. A ce stade, le nuage clairsemé n’est pas encore disponible.

En mode télémétrie, trois boutons apparaissent en haut a droite. Le troisieme bouton sert a afficher les noms des images.

Par défaut, toutes les images importées sont sélectionnées. Le panneau de travail indique le nombre d'images
sélectionnées parmi les images disponibles. Le bouton Deselect permet d’exclure certaines images du traitement.
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Pour délimiter les caméras a désélectionner, dessiner un polygone avec le bouton gauche de la souris, puis fermer et
valider avec le bouton droit. Les images désélectionnées passent du bleu au gris et sont décochées dans la liste du
panneau de travail.

Cas d’usage : la désélection est utile pour traiter par morceaux les jeux de données de plus de 1000 images ou pour exclure
des images inutiles : panoramas, décollage, montée a la hauteur de vol, images hors zone, etc.

4.3.3. Explication avancée des systemes de coordonnées (PH, S)

Lors de l'import de la télémétrie des images ou des GCP, il faut sélectionner le systéeme de coordonnées des données et
celui du projet.

La fenétre de définition permet de choisir des préréglages créés par le logiciel pour différentes régions, de charger des
préréglages aux formats PRJ ou WKT, ou de configurer un systéme personnalisé.

En mode personnalisé, I'utilisateur peut définir séparément le systeme horizontal et le systéme vertical. Cliquer sur le nom
du systéme, saisir le nom ou des mots-clés, puis sélectionner le systéme souhaité.

Les systémes personnalisés peuvent étre sauvegardés en différents formats : WKT, PRJ ou JSON.
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4.32. Commands for images (PH)

At the top left of the Viewer, you will see four buttons, Images, Maps, Telemetry and Sparse point cloud to view the
data in your preferred mode. At this stage, Sparse point cloud is not available. When in telemetry mode, three buttons
appear in the top right-hand comer.

The third button is for displaying image names. By default, all imported images are selected the number of images selected
from those available is shown in the work panel. Use the Deselect button to exclude any number of images from the group
setting. Use the left mouse button to draw the polygon surrounding the desired cameras. Close the polygon and confirm
your selection with the right mouse button. The deselected images will change colour from blue to grey and in the list of
images in the working panel, the deselected images will be unselected. If you want to include some of the deselected ones,
click on the Select button to reselect them, or dock them in the image list. This has intrinsic value in two cases:

*  When a dataset of more than 1000 images is processed, probably the most efficient way would be to process
them by parts;

»  You can easily de-select images that are not important for your project and would only increase the processing
time of your project - panoramic images, images while lifting the drone to the exact height, etc.

4.3.3. Advanced Explanation on Coordinate Systems (PH, S)

When importing image telemetry data or ground control points, the data and project coordinate system must be selected.
‘When assigning the preferred project coordinate system, as described in 4.3.1, you may be interested in the data displayed
along the selected coordinate systems.

In the window you can select presets created by the software for different regions, load presets in PRI/WKT formats or set
up a custom system.

If you are working in custom mode, you can select either a horizontal or vertical system for your system. Click on the name
and type in the system name or keywords to search for it

Once selected, click select. The custom datasets created can be saved in different formats (WEKT, PRJ, JSON) by clicking on
the icon at the bottom right of the main software screen.
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Page source 23 - modes Images/Maps/Telemetry et paramétrage avancé des systemes de coordonnées.

4.4. Ajustement de faisceaux / Bundle Adjustment (PH)
Si des parameétres de calibration caméra sont disponibles, cliquer sur Load camera parameters pour les charger. Ces

données accélérent et stabilisent le calcul de 'ajustement de faisceaux. Pour les drones courants, comme DJI Phantom 4,
Phantom 4 Pro ou Mavic, les paramétres prédéfinis sont déja intégrés au logiciel.

Pour les autres caméras, il est conseillé de calibrer la caméra sur un premier projet puis de réutiliser ces paramétres sur
les projets suivants.

Le nombre total d'images utilisées est affiché au-dessus du bouton Bundle Adjustment. Cliquer sur ce bouton pour calculer
les parametres d’orientation des caméras.
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Modes d’ajustement

Mode Usage recommandé

Global Méthode plus rapide, adaptée aux grands jeux de données. A
utiliser par défaut.

Incremental Méthode plus lente mais plus stable, adaptée aux projets avec

texture faible, mauvais recouvrement, végétation haute ou
images floues. Conseillée jusqu’a environ 500 images.

Hybrid Combinaison des modes Global et Incremental. Fournit
généralement le meilleur résultat mais c’est aussi le mode le plus
lent.

Options avancées Show more

e Maximum CPU workers : nombre de processeurs ou threads travaillant ensembile.

¢ Maximum detected features : nombre maximal de points caractéristiques extraits des images.

e Feature detection level : niveau de détection, Normal, High ou Extreme.

e Pair selection : méthode de sélection des paires d’'images - Telemetry, Generic, Sequential ou All.
e Use telemetry data : utilise la télémétrie drone pour orienter le nuage.

Cliquer sur OK pour lancer I'ajustement de faisceaux. Le temps de traitement varie de quelques minutes a plusieurs heures
selon le nombre d’images et les performances CPU.

Bonne pratique : enregistrer le projet apres chaque opération importante : Bundle Adjustment, Orientation et Reconstruction.
Les versions récentes disposent également d’'une sauvegarde automatique.

Toutes les images doivent provenir d'un méme dossier pour étre traitées comme un seul projet. Certains drones créent un
second dossier aprés 1000 images et recommencent la numérotation a 001.jpg ; il faut alors renommer les images du
second dossier puis tout regrouper.

4.4.1. Dépannage Bundle Adjustment

Si seules une partie des images sont appariées, les causes fréquentes sont un recouvrement insuffisant, une texture faible,
une végeétation importante, des zones d’eau ou des images floues.

Premiére action : relancer I'ajustement en mode Incremental.

Si le résultat reste insuffisant : ouvrir le dossier 3Dproject, supprimer manuellement le dossier Features, puis augmenter
Number of maximum detected features a 80 000 dans les options de Cube-3d.

Si nécessaire, augmenter également Feature detection level de Normal vers High ou Ultra. Aprés calcul, remettre les
valeurs par défaut afin de ne pas rallonger inutilement les traitements standards.
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o Sequential: use in case of images extracted from video. Select images sequentially.
o All: Try to use all the previous methods.
= Use telemetry data: if you have drone telemetry you can orient the cloud with it.

Click OK to start Bundle adjustment. The processing time could be between a couple of minutes and up to several hours.
It depends on the number of images and your CPU specifications (number of cores...)

Note: Try to save your project after every operation (Bundle Adjustment, Orientation and Reconstruction). It can be done
through Toolbar Project > Save project. The latest version also has autosave, which makes that for you.

Allimages must be imported from a single folder to be processed as one project. Some of the drones start to write images
in a second folder after 1000 created images and start once again with the image name 001,jpg (Phantom 4 Pro). In this
case rename the images in second folder and copy all in one folder.

Once project is bundle adjusted, you can observe several functions in the viewer. As before, you can watch images, or click
telemetry, to observe location and orientation (external orientation) of images. Toggle text, to view or not image names.

Click sparse point cloud to observe sparse point cloud beneath telemetry data. There, you can toggle text, select or
deselect desired camera positions or click convert to point cloud that shifts your position in the working panel from
Images to point cloud.

4.4.1. Bundle A
If bundle adjusted set of images is beneath your expectations, here are some guidance, that might help.

In case, that matches were found on only haif of the selected images (probably due to insufficient overlap, bad texture on
images, high vegetation, images of water areas that are blurry) you may get better results by:

- recomputed Bundle Adjustment using Incremental mode. If results aren't better, proceed,

- goto 3Dproject folder, and inside the folder with images manually delete folder named “Features”. Then increase
Number of maximum detected features to 80.000 in Cube-3d -> Options. Results should be better.

If the results are still insufficient: repeat the step 2. and increase also Feature detection level from Normal too High or Ultra.
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Page source 25 - visualisation du nuage clairsemé et recommandations de dépannage.

4.5. Orientation / géoréférencement (PH)
Pour géoréférencer un projet, utiliser la fonction Orientation. Trois options sont disponibles selon les données disponibles.

4.5.1. Orientation avec données de télémétrie

Si la télémétrie est disponible et correctement importée, les images peuvent étre orientées uniquement a partir de ces
enregistrements. L’'usage de GCP reste toutefois recommandé pour améliorer la précision.
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Cliquer sur Orientate with telemetry data et suivre I'assistant. La premiére étape permet de vérifier la position des images
dans le systéme de coordonnées défini. Certaines lignes peuvent apparaitre en gris si la télémétrie contient des erreurs.

La fenétre Orientation summary présente les résidus des positions caméra ajustées sur les trois axes ainsi que I'erreur
spatiale. Cliquer sur Finish pour terminer I'orientation. Les images avec erreurs de télémétrie apparaissent comme non
enregistrées dans la liste des images.
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After computation, set all changed parameters back to default, because made changes increase processing time and are
unnecessary for standard datasets.

Default values of Number of maximum detection features is 40.000. Feature detection level is, by default set to Normal.
Orientation (geo-referencing) (PH)
To geo-reference a project, proceed with Orientation. Three options are available depending on your data type.

4 57 QOrienta

In case of available and imported telemetry data, you can orientate images using just telemetry recordings, although it is
recommended to use GCPs to achieve better accuracy. Remember, in the process of Bundle ad nent you selected
weather you wish to orientate images or not.

To proceed, click Orientate with telemetry data and follow the pop-up wizard. First you inspect location of images in
assigned coordinate system. Some rows might be seen in grey colour as image's telemetry has error. To proceed, click
Next.

Stonex Cube-3d - User Manual 26

Page source 26 - orientation a partir de la télémétrie.
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4.5.2. Orientation avec GCP

Dans la majorité des cas, surtout lorsque la télémétrie est absente ou insuffisamment précise, le bloc d’images est orienté
a I'aide de points de contréle au sol. Ces points sont mesurés avec un GNSS ou une station totale.

Cliquer sur Orientate with GCP et suivre I'assistant. Sélectionner le fichier des points de contréle au sol au format TXT,
puis cliquer sur Import. Définir le séparateur du fichier et associer chaque champ au type de donnée correspondant. Les
champs inutiles peuvent étre ignorés en choisissant NONE.
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Orientation summary window presents residuals of adjusted camera positions on all three axis and its spatial value. Click

Finish to complete orientation. If some images have errors in telemetry, they appear as unregistered in the List of images
in Working panel.

Orientate with GC
In most cases, especially when telemetry data cannot be measured, or it isn't accurate enough (most UAVs caries GPS
antenna with 1.5m accuracy), block of images is orientated using ground control points (GCPs). Position of GCPs are

measured using GNSS services or by total stations.

To proceed, click Orientate with GCP and follow the Orientation pop-up wizard. First, select ground control points (* txt)
file and click import. Define the file delimiter. You can change the type of data to be read in each field, and you can ignore
some fields by putting NONE on the column. Finally, choose the reference system.
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Page source 27 - import du fichier GCP et choix du systeme de référence.
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L’écran suivant permet de définir le type de cible utilisée, sa taille et le réle de chaque point : GCP ou point de validation.
Un GCP est utilisé dans le calcul d’orientation ; un point de validation est exclu du calcul et sert uniquement a I'évaluation
qualité.

Si le mauvais systéme de coordonnées a été choisi lors de I'import initial des images, il n’est pas possible de le modifier a
cette étape. Il faut soit recommencer le projet, soit utiliser I'option Local coordinate system.
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Greurd Centrel Peints Imperter x

In the next screen you can define the type of target used, its size and the method of use of the control point. Click an the
field after the points name and select whether it is a ground control point (GCP) or a validation point:

»  GCP - its reference coordinates are used in the orientation adjustment,
+ Validation peint - excluded from orientation adjustment and used for quality assessment at the end of the process.

In case you select the wrong coordinate system by importing the images into project, be reminded that you cannot change
project coordinate system in this step. If you would like to correct this you need to start from the beginning (Mew project,
-..) or use the second option - select: Local coordinate system. Further information about coordinate systems can be found
in chapter Bundle Adjust t hooting
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Page source 28 - configuration des GCP, points de validation et systemes de coordonnées.
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4.5.3. Orientation automatique

Dans la fenétre d’orientation, sélectionner a gauche une image contenant un GCP. Utiliser la molette pour zoomer. Pour
I'orientation automatique, au moins 3 GCP doivent étre marqués manuellement.

Marquer un GCP avec le clic droit. La position marquée apparait en orange avec un point d’interrogation tant que son nom
n’est pas défini.

Aprés avoir marqué trois GCP dans des zones différentes du projet, la reconnaissance automatique des autres GCP
démarre. Les GCP détectés automatiquement apparaissent en vert et leurs noms sont identifiés.

Si une position a été mal marquée, utiliser Clear all marks puis recommencer. Les résidus permettent de vérifier la
cohérence des GCP. Des déplacements élevés signalent souvent un point absent du fichier ou mal identifié.

S

STONEX

If you continue, you will end up in the screen for selecting control points within the images.

a0 : 'Jf:'
GCP Map

45.3. Automatic orientation

On the left of the pop-up window, select image with GCP. Use mouse scroller to zoom in or out. For automatic orientation
a minimum of 3 GCPs need to be manually marked. Mark GCP with a right mouse click. Marked position is coloured in
orange and ascribed a "?"” as its name is not defined.
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Page source 29 - sélection initiale des GCP pour orientation automatique.

Continue by selecting additional two GCPs from other segments of your project area. When you select the third ground
control point the automatic recognition for all other GCPs will start. Three marked GCPs remain orange coloured while
automatically found GCPs are now coloured green and the names of all GCPs are identified.

If you mismark the position of the ground control point, click Clear all marks button and reselect. Otherwise, click Confirm
unknown marks. A useful tool for checking the appropriation of GCPs are their residuals. If displacements of selected points
are high, you should check if you forgot to survey one of them (their position is missing in the file). Described method of
Automatic orientation as furtherly described Troubleshooting with orientation in chapter Troubleshooting with orientation.

4.54. Semiautomatic orientation

Use GCP Map and select first the name of the ground control point on GCP map with left mouse click (for example 2009)
and mark its position on image with left mouse click. Marked position is coloured blue, and its id appears.

If you mismark the position, click Clear mark button and reselect. Clear all marks button clears all selected markers.

Stonex Cube-3d - User Manual 20

Page source 30 - reconnaissance automatique aprés sélection de trois GCP.

4.5.4. Orientation semi-automatique
Utiliser la carte des GCP pour sélectionner le nom du point, puis cliquer sur sa position dans I'image. La position marquée
apparait en bleu avec son identifiant.

En cas d’erreur de pointage, utiliser Clear mark ou Clear all marks pour supprimer les marquages.

Apres trois GCP sélectionnés, la reconnaissance automatique des autres points démarre. Les GCP détectés sont affichés
en vert avec leur nom.
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Les résidus affichés en bas a droite doivent rester faibles, typiquement inférieurs a 1 m lors de cette étape. Si certaines
positions automatiques sont incorrectes, les corriger manuellement en sélectionnant le point dans la carte puis en indiquant
sa position exacte dans I'image.

Avec les cibles STONEX, activer Detect targets et renseigner le diamétre correct du point noir. La valeur par défaut est
0,27 m pour la cible standard Cube-3d. Pour des détails naturels ou artificiels, comme plaques d’égout ou angles de
batiment, désactiver Detect targets.

L’étape suivante affiche la reconnaissance automatique des GCP. Si un GCP n’est pas reconnu sur une image, il est
éliminé et affiché en rouge. Pour I'inclure, double-cliquer sur 'image afin de supprimer 'overlay rouge.

Il est possible de corriger ou recentrer une mesure automatique en déplagant le centre du GCP vers la croix verte. Le clic
droit placé au centre de la cible permet un recentrage plus rapide. La molette ou la barre de zoom facilite I'alignement des
fenétres de cible.

Lorsque le méme jeu de données est réutilisé, exporter les positions image des GCP centrés depuis l'icone engrenage. A
la prochaine relance, il suffira d'importer ce fichier au lieu de repointer les cibles.
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Select two more GCPs with a left mouse click (same as above). When you select the third ground control point the
automatic recognition for all other GCPs will start. GCP are now coloured green and the names of all GCPs identified.

In the lower right corner appears the residuals of marked points. Residuals should be within 1m. Check if the automatic
positions are calculated correctly - GCPs need to be coloured green. If not, correct them with manual selection. First, select
the name of GCP on GCP map, then show the exact position of GCP map on an image. Use left mouse click.
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Page source 31 - correction manuelle des GCP et contréle des résidus.
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In case you are using STONEX GCP targets (black dot on white plate) be sure to select the "Detect targets” and set the
correct diameter for the black dot. The default value for diameter is 0,27m (standard Cube-3d target). In case you are using
some detail points for orientation as holes, road marks, building corners... deselect "Detect targets” click next to

continue with orientation.

In the next step, we can see automatic recognition of ground control points (in case of Cube-3d targets). If the GCP is not
recognised on a specific image, it is eliminated and coloured red. If you want to include this GCP into orientation, just
double click the image and the red overlay will disappear. Several images can be marked or unmarked by ticking them in
their upper left corner, where unticked square appears. Use Ctrl + A shortcut to select all target windows at once. You can
also correct/realign the automatic measurement - left mouse click and move the centre of GCP to the green cross. Same
approach can be used to correct the positions of GCPs that have been automatically detected but not measured perfectly
because of the bad conditions during data acquisition.

Egnnnnnnnnnnnn
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Faster approach for centring target is provided by the right mouse click. Put the mouse in the centre of the target and right

mouse click for centration. Use mouse wheel or slide bar below to zoom in or out, which works for all target windows to
realign easier.

If you are using the same dataset in numerous computations/projects it can be useful to export GCP image positions of
centred targets. Click tooth wheel button in the upper right corner and click export. In case if you calculate the same
project again next time you don't need to select and correct the GCP targets once again but just import the saved file and
go to next step.
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Page source 32 - détection de cibles et recentrage des GCP.

La fenétre Orientation summary affiche les erreurs GCP, combinant les mesures photogrammeétriques et les mesures
GNSS/station totale. Vérifier les résidus ; si certains points affichent des écarts élevés, revenir en arriere et corriger le
marquage. Une fois le résultat satisfaisant, cliquer sur Finish et sauvegarder le projet.

Pour un contréle indépendant, certains points peuvent étre définis comme Validation points. lls ne participent pas au calcul
d’orientation et sont affichés en gris.
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Click Next, to observe orientation’s accuracy.

Orientation summary displays GCP errors — a sum of photogrammetric measurements and total station /GPS measurements.
Check GCPs accuracy by observing their residuals. If residuals show high displacements of certain GCPs, go and recheck
them. Click back button on the upper left comer and repeat the marking process. Click Finish when satisfied. Remember
to save the project.

Ormentatusn sumemary

To check for independent accuracy quality, GCPs can be marked as Validation points that provide independent values to

compare against GCP values. Points defined as Validation points get coloured grey.
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Page source 33 - résumé d’orientation et utilisation des points de validation.

4.5.5. Dépannage de I’orientation

Si les marqueurs sélectionnés automatiquement sont incohérents et que les résidus dépassent la limite acceptable, cliquer
sur Clear all marks puis passer en orientation semi-automatique.

Vérifier que les points sélectionnés disposent bien de coordonnées dans le fichier TXT. Si un marqueur sélectionné n’a pas
de coordonnées observées ou si un point est déclaré a tort comme point de contrdle, les résidus afficheront des écarts
importants.

Si le flux standard est correct, poursuivre ensuite avec la reconstruction.
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4.5.6. Orientation d’un jeu de données inconnu

Lorsqu’un jeu de données provient d’un collégue et que la carte de localisation des GCP n’est pas disponible, plusieurs
approches sont possibles.

Utiliser la méthode d’orientation automatique lorsque les cibles et leur répartition le permettent.

Définir tous les GCP comme points de validation, puis utiliser I'orientation semi-automatique uniquement sur les points dont
la position est certaine. Observer les résidus et supprimer les points incohérents.

Cette méthode peut étre longue sur les grands projets. La bonne pratique reste de produire et conserver une carte des
positions de GCP et points de validation.

S

STONEX

Orientation summary

0.030

0.011

0.041

0.005

0,013

0.006

0024

0,022

0.027

In the orientation summary, you can observe adjusted accuracy presented with residuals. As four points are used as control
points, arientation is computed based only on selected GCPs. As described above, residuals need to be low. Impact of their
size can be observed on residuals of control peoints. In case of high values markings need to be corrected.

4.5.5. Troubleshooting with orientation

In case it automatically selected point markers mismatch - residuals show large coordinate differences, that exceed 1m
limitation for presentable final centring, as presented below - you should click clear all marks and proceed semiautomatic
orientation, as described above. Keep in mind that selected points need to be observed - have observed coordinates
written in *.txt. If at the beginning of the orientation, at least one of selected markers is declared as control point, residuals
will show misplacements.

If you would like to continue with the standard workflow, continue with the Fe

4.5.6. Orientation of unknown dataset

Sometimes you need to process dataset of one of your co-workers. You weren't present during field work and you do not
have any map of positions of GCPs. There are several ways to proceed:

on method

*  Select all GCPs as validation points and use Semigutomatic orientation method for GCPs you are shore of its
position. Observe residuals from the list, and if for some GCP values are high, select it from the list or click on it in
the map and click clear mark. It is time consuming process especially when processing large datasets. Itis highly
recommended to make and archive some map of GCP / validation point locations.
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Page source 34 - dépannage orientation et cas des jeux de données inconnus.
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4.6. Fonctions avancées (PH)

4.6.1. Export des parameétres caméra et images non distordues

Pour importer les résultats de Bundle Adjustment dans un autre logiciel photogrammétrique, exporter les paramétres
caméra et les images non distordues. Ouvrir Data, choisir Export camera parameters, saisir un nom de fichier ou conserver
le nom proposé, puis valider.

4.6.2. Export des images non distordues
Ouvrir Data puis choisir Export undistorted images. Dans la fenétre, indiquer le dossier de destination et le nom de I'export.

STONEX
4.6 Advanced functionalities (PH)

4.6.1. Export camera parameters and undistorted images

If you would like to import results of Bundle Adjustment in any other photogrammetric software, you need to export camera
parameters and undistorted images. Click Data, chose export camera parameters. Type preferred name of exported
document or chose predetermined one and confirm.

4.6.2. Export undistorted images

Click Data and chose export undistorted images. In the popup window assign path of directory and type in its name.
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Page source 35 - export des parametres caméra et des images non distordues.
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4.7. Reconstruction (PH)

Aprées I'assistant d’orientation, I'étape suivante est la reconstruction du nuage de points dense. La boite de dialogue permet
de régler les parameétres de reconstruction du nuage ainsi que les étapes optionnelles de création de produits
photogrammétriques comme le maillage 3D et la True Orthophoto.

Cliquer sur OK pour lancer la reconstruction.

Quatre niveaux de reconstruction sont disponibles : Low, Medium, High et Extreme. Le choix du niveau a un impact direct
sur le temps de traitement, la densité du nuage et les ressources nécessaires.

Lorsque la reconstruction démarre, I'onglet Point cloud est déverrouillé dans le panneau de travail. Le visualiseur affiche
une barre de progression. L’estimation de temps devient généralement réaliste aprés environ 7 % de calcul.

STONEX

Reconstruction (PH)

When you are finished with orientation wizard the main window will appear. Next step is Reconstruction of dense point
cloud. In the dialog box, you can set the cloud reconstruction parameters, as well as the subsequent steps for creating
photogrammetric products such as 3D Mesh and True Orthophoto. For more details on these products, refer to the
dedicated sections of the manual.

&' Reconstruction

Click OK to start reconstruction.
Below, each reconstruction parameter is described for more information.

Reconstruction level - there are 4 levels of reconstruction:

o Low,
e Medium,
e High,

e Extreme.

As the reconstruction is in progress, the Point cloud tab unlocks in Working panel. In the Viewer, the progress bar displays
the stage of completed processing. The predicted processing time is realistic after 7% of the process is computed.
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Page source 36 - lancement de la reconstruction dense.

Reconstruction avancée

Comme décrit dans les réglages, il est possible de choisir les images utilisées pour reconstruire le nuage. Lorsque toutes
les images sont orientées, un nuage peut étre reconstruit a partir d’'une seule image sélectionnée, mais Cube-3d exploite
aussi les images qui la recouvrent pour conserver la qualité de surface.

Cette fonction permet de traiter un projet en plusieurs parties, par exemple premiére moitié puis seconde moitié, ou de
calculer une zone centrale en niveau Extreme et une zone secondaire en High ou Medium.

L’exemple du manuel montre un nuage reconstruit depuis une image sélectionnée et ses images de recouvrement, coloré
en violet au sein du nuage complet. Méme avec une image issue de la premiére rangée, environ 700 000 points ont été
reconstruits.
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Reconstruction advances

As described in Option settings desired images can be chosen to reconstruct point cloud from. When all images are being
orientated, point cloud can be reconstructed from only one selected image. Although you chose only one image, app runs
reconstruction with all of overlapping images, with same detail of surface. Select preferred images and run reconstruction.
You can use select or deselect button or manually deselect images from the image list. Further assign desired level of
reconstruction, number of overlapping images and possibility of optimization.

This function allows you to process the dense reconstruction for one project in two pairs (15 half and 2" half) or calculate
the dense reconstruction with a different level - for example: centered area with Extreme level, less important area on High
or Medium level.

To see the effect, we selected point cloud {coloured purple) reconstructed from one selected image with its overlapping
images selected amongst point cloud reconstructed from entire batch of images. Although selected image was from the
first row of images, about 700.000 points were reconstructed.
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5. Recalage des nuages de points (S)

5.1. Recalage manuel (S)

Importer les nuages de points a recaler. Ouvrir 'onglet Point Cloud, puis cliquer sur Load. Les nuages chargés sont
affichés dans la zone de visualisation. Une fois les données chargées, cliquer sur Manual Registration dans la zone des
outils.

Dans la fenétre de recalage, les deux nuages sont affichés cote a cote : a gauche le nuage a recaler, a droite le nuage de
référence. Il est possible d'importer un fichier de coordonnées GCP pour chacun des nuages en cliquant sur I'icbne de
dossier correspondante.

Dans Options, I'utilisateur peut changer le mode d’affichage : couleur réelle, intensité, échelle de hauteur ou autres
attributs disponibles. Il est également possible d’augmenter la taille des points pour faciliter le pointé.
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5. Point clouds registration (S)

Import the point clouds you wish to register. Click on Point Cloud, then click on Load. Both point clouds will be
displayed in the viewing area. Once loaded, click Manual Registration in the tools area.

In the registration window, the two point clouds will be displayed side by side in two windows. On the left the one to
be recorded, on the right the reference one. You can import a GCP co-ordinate file by clicking on the folder icon of
both point clouds.

Under ‘options’ it is possible to switch between colour and other colour displays such as intensity or height scales, and
it is also possible to increase the size of the dots.
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Page source 38 - chargement de deux nuages et lancement du recalage manuel.

Si aucun GCP n’a été mesuré, ou si 'on souhaite compléter le recalage, les correspondances peuvent étre créées
manuellement. Dans la fenétre de recalage, double-cliquer sur un nuage pour I'agrandir, naviguer vers un point facilement
identifiable dans les deux nuages, puis cliquer pour créer une nouvelle correspondance.

Deux points homologues doivent porter le méme nom pour étre correctement reliés. Si les scans ont le méme nivellement,
I'axe Z peut étre verrouillé avec Fix z-axis. Il est également possible de verrouiller I'échelle avec Fix scale.

La partie centrale affiche un apergu des erreurs. L'option Generate report permet d’enregistrer un rapport avec les résidus.
Un point peut étre supprimé en cliquant sur le x placé a c6té. Une fois le recalage satisfaisant, cliquer sur Save.

T=CH4 \yAPS

Cube-3d - Manuel utilisateur FR | Source Stonex User Manual Ver. 4.0.1



STONEX

You can create matches manually if no GCPs have been collected or if you wish to add more. In the registration window,
double-click on a point cloud to enlarge it. Navigate to a recognisable point in both point clouds, then dick to create
a new match. Two matching points must have the same name to be connected correctly.

You can also fix the Z-axis {fix z-axis) if the scans have the same levelling or fix the scale (fix scale).

In the central part you can see a preview of the errors. By marking Generate report you can save a report file with the
residues. You can delete a point by clicking on the 'x’ next to it When finished, click Save.
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Page source 39 - création manuelle de points homologues et options Fix z-axis / Fix scale.

Le rapport de recalage présente les erreurs moyennes et les résidus de chaque correspondance : erreur 3D globale et
erreur par coordonnée.

5.2. Recalage automatique ICP (S)

Pour affiner automatiquement un recalage, faire un clic droit sur le nom du nuage de points concerné. L’algorithme ICP est
alors utilisé. Le recalage automatique peut aussi étre activé depuis le bouton situé en bas a droite de la zone d’outils.

Sélectionner le nuage a recaler, le nuage de référence, puis choisir le mode ICP : Fast, Normal ou Accurate. Comme pour
le recalage manuel, un rapport peut étre généré en cochant I'option correspondante.
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Le mode Fast privilégie la vitesse ; Normal constitue le compromis de base ; Accurate est a réserver aux recalages
nécessitant une précision plus fine, avec un temps de calcul supérieur.

S

STONEX

Here is an example of a registration report. The average errors and residuals for each match are shown as 3D error and
error for each coordinate.

Point list registration report
Project: New project

lun novembre 28 2022

Mean registraiion error 0,0119m
Mean target registration error components 0.0126m, 0.0123m, 0.0109m

§ correspondences found

Point 1D, 3D error, X error, Y error, Z error
1, 0.0276m, 0.0103m, 0.0246m, 0.0068m
2, 0.0148m, 0.0116m, 0.0023m, 0.0088m
3, 0.0350m, 0.0211m, 0.0062m, 0.0272m
4, 0.0120m, 0.0101m, 0.0053m, 0.0038m
5, 0.0264m, 0.0098m, 0.0233m, 0.0078m

Right-click on the name of the point cloud whose registration you wish to refine. The ICP algorithm is used at this stage
You can also click on the button at the bottom right of the tool section to activate automatic registration.

Select the paint cloud you wish to record and the reference cloud, then also select an ICP mode from Fast, Normal and
Accurate.

Stonex Cube-3d - User Manual 40

Page source 40 - lancement du recalage ICP et choix du mode Fast/ Normal / Accurate.
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A report can be generated, as for manual recording, by ticking the corresponding option.

Automatic alignment

Here is an example of an ICP report

ICP report
lun dicembre 19 2022

2 clouds have been registered:
texture_optimae_fiter_optimised _2022-11.17_15.48.28 732
texture_optman_fiter_optimised_2022-11-17_01-23-20_506

Registration sequence in readble form:
Cioud texture_opSimize_fiter_optimised_2022-11-17_01-23-20_506 is preregistered on doud lexiure_optirmize_fi

Transformation matrices:
teature_optimize_fiter_optimised_2022-11-17_01.23-20_506
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Page source 41 - exemple de rapport ICP.

6. Manipulation des nuages de points (PH, S)

Le nuage de points calculé apparait dans I'onglet Point Cloud. Pour manipuler le modéle : clic gauche pour faire pivoter le
nuage, molette pour zoomer, clic maintenu sur la molette pour effectuer un déplacement panoramique.

Un nuage de points contient généralement le terrain, les batiments, la végétation et les objets présents sur la scene. Pour
produire une orthophoto numérique propre, les obstacles doivent étre supprimés afin d’obtenir un modéle numérique de
terrain exploitable.
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6. Point cloud manipulation (PH, S)

The calculated point cloud will appear in Point Cloud tab. To manipulate the point cloud: use left mouse click to rate point
cloud, scroll to zoom in or out, click and hold the mouse scroller to pan the model.

Point Cloud includes points from surface, buildings, vegetation and other objects. To generate a digital Orthophoto those

obstructions need to be eliminated (select and delete) as to get a clear digital terrain model that serves as a basis for
Orthophoto generation.
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Page source 42 - affichage du nuage de points dans Cube-3d.

6.1. Rendu des points (PH, S)

La barre Point render size permet d’augmenter ou de réduire la taille d’affichage des points du nuage. Ce réglage n’altére
pas les données ; il agit uniquement sur la visualisation.

6.2. Accrochage sur point / Point snapping (PH, S)

L’outil Point snapping permet de consulter les coordonnées 3D d’un point du nuage. Les valeurs X, Y et Z sont affichées
dans la fenétre de commande en direct, située en bas a droite.
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Point rendering (PH, S)

Use the Point render size bar to increase or decrease the points of Point Cloud.

6.2 Point snapping (PH, S)

Use the Point snapping tool to inspect the 3D coordinates of the point cloud. The x, y, z values are presented in the live
command window (lower right corner).
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Page source 43 - taille de rendu des points et consultation de coordonnées 3D.

6.3. Visualiseur Cube-3d (PH, S)

Reset view rétablit la vue par défaut.

Top down affiche le nuage de points ou le DSM en projection nadirale (vue ou une projection réalisée strictement depuis le
dessus, comme si la caméra regardait le sol a la verticale). Le modéle ne peut alors étre tourné qu’autour de I'axe Z tant
que le bouton reste activé.

Ortho mode permet d’afficher le nuage en projection orthogonale. Lorsque la fonction est active, le bouton devient bleu.
Pour retrouver une rotation libre sur tous les axes, désactiver Ortho mode.
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Free flight permet de réaliser des déplacements fluides autour du modeéle 3D, notamment pour préparer de courtes
captures vidéo avec un outil externe. La navigation combine clic gauche et clavier : A gauche, D droite, W avant, S arriére,
F zoom avant, R zoom arriére, V recentrage. La molette régle I'angle vertical de vue ; + accélére le déplacement et - le
ralentit.

)
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6.3 Cube-3d viewer (PH, S)

Use Reset view to set the default view.

If you would like to view PC or DSM from nadir projection, dlick Top down button. Model can now be rotated only around
z-axis. The button is on as long as you do not switch it OFF.

Prpect magm Ot Purt ot DOM _ Orthaghets Opbans ey

If you would like to view the point cloud in orthogonal projection, you need to click Ortho mode button. Enabling the
function results in the button colouring blue. To rotate around all axes, disable the Orto mode by selecting the function
one more time.

Prejoit  Wmagr Outs Powt deed DU Ocheghets Oyters M
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If you would like to capture short movies from your 3D model with an external software, you can use Free flight function
and smoothly fly around 3D model and objects. Use: left mouse click + keyboard. A to move left, D to move right, W to
move forward, S to move backward, F to zoom in, R to zoom out, V to zoom in centre. Scroll to set vertical angle of view.
To speed up the flaying press +, to reduce speed press -.

Pragit bmoges  Outs Dot ined  DGM  Ortbughots  Optuns Mo
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Page source 44 - commandes Reset view, Top down, Ortho mode et Free flight.

Point cloud & DSM affiche simultanément le nuage de points et le modéle numérique de surface. Cette fonction est
disponible dans les onglets CAD, Point Cloud ou DSM ; elle est utile avec Point Picking.

Cameras affiche les positions des caméras au-dessus du terrain reconstruit. Cette fonction est disponible dans les onglets
CAD, Point Cloud ou DSM.
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Bounding Box sert a inspecter une zone 3D : les plans de coupe peuvent étre déplacés pour isoler les données a l'intérieur
de la boite et ignorer le reste du nuage. En rapprochant deux faces opposées, on obtient un profil 3D de la surface.

La boite englobante peut étre déplacée dans le modéle avec CTRL + clic gauche sur une face. Elle peut aussi étre tournée
autour du centre du nuage en cliquant sur ses arétes. L'activation de Height map rend les différences d’altitude plus
lisibles.

Usage opérationnel : charger deux nuages mesurés a des dates différentes sur une méme zone, appliquer des couleurs
distinctes puis utiliser Bounding Box permet de visualiser rapidement les évolutions de terrain.

S
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IF you wish to see PC and DSM at the same time, click Point cloud & DSM button. You can use this function in CAD tab,
Point Cloud tab or DSM tab. This is a useful tool when you are working with Point Picking function.

If you wish to see positions of cameras above the point cloud - reconstructed terrain, click Cameras. You can use this
function in CAD, Point Cloud or DSM tab

Preect bagns Dt 4 Odteghots Optess e
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Bounding Box - It is a useful tool for two reasons.

First, move sections freely left, nght, up or down and the tool lets you easily inspect the data inside the box whilst ignoring
everything outside your box selection.

Second, sliding 2 opposite Bounding Box panes together gives you a 3D profile of the surface model.

Third, click and drag on any of the rims of Bounding Box and rotate bounding box around point cloud centre. To move
through the 3D model press CTRL and left-click on the Bounding Box pane and you will be able to slide it in any direction

and explore all the sections on the fly. Turning on the Height map displays the height differences even more clearly.
Use Bounding box in either point cloud tab or DSM tab.

It is possible to inspect the differences between several point clouds or surfaces, of course. For example, loading two-point
clouds from the same area but measured at a different time and using Bounding Box will clearly show the difference. Apply

different colours to surfaces for even more impressive results.
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Page source 45 - Point cloud & DSM, Cameras et Bounding Box.
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Recorder permet d’enregistrer des parties du projet calculé et de mettre en évidence des détails. Cette fonction est
pratique pour réaliser une présentation rapide du projet ou des calculs effectués.

6.4. Sélection des points (PH, S)

Cliquer sur Select, puis dessiner un polygone autour de la zone a sélectionner avec le bouton gauche de la souris.
Terminer la sélection avec le bouton droit. Les points sélectionnés changent de couleur.

Deselection permet d’exclure des points de la sélection courante. Le principe est identique : clic gauche pour tracer, clic
droit pour finaliser. La touche ESC annule I'opération ; Clear efface la sélection.

En cliquant sur le triangle associé a 'outil, la sélection peut aussi étre réalisée a partir de données CAD ou a partir d'une
couleur du nuage.

La sélection par couleur ouvre une fenétre interactive affichant un apergu de la couleur choisie. Le paramétre de tolérance
permet de sélectionner plus ou moins de points similaires. Cliquer sur OK pour valider la sélection.
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IF you wish to record desired parts of computed project and highlight significant details, click Recorder button. You can
use this function in CAD tab, Point Cloud tab or DSM tab. This is a useful tool when you need to make quick presentation
of project and made calculations.

o TN T =

Click Select button and draw polygon around surveyed area using left mouse click. Finish the selection with right mouse
click. Selected points will be coloured.

Use the Deselection function to ignore interested points from selection. Left mouse click to select, with right mouse click

to finish selection. Use ESC on keyboard to cancel selection or click clear button.

If you click on the triangle, it will also be possible to make the selection based on CAD data or by selecting a colour from
the cloud.

Selecting a colour will open an interactive window giving a preview of the selected colour and you can change the tolerance
parameter to select more or fewer points of similar colour. Clicking OK will select the corresponding points and you can
decide what to do with this selection.
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Page source 46 - sélection par polygone, désélection, CAD ou couleur.

6.5. Suppression de points (PH, S)

Pour supprimer des points, il faut d’abord les sélectionner. Les points sélectionnés peuvent étre supprimés via Delete
selected ou avec la touche Suppr du clavier. Delete other supprime tout ce qui n’est pas sélectionné. Les fonctions Undo et
Redo permettent de revenir en arriére ou de réappliquer I'action.

6.6. Modification des points (PH, S)

La fenétre Manipulate points permet de définir une hauteur, d’augmenter ou diminuer une hauteur, ou de calculer la
hauteur moyenne d’une zone sélectionnée.
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Aprés avoir sélectionné la zone souhaitée, cliquer sur Set height, saisir la nouvelle altitude, puis valider avec OK. Les
points sélectionnés sont déplacés en conséquence.

Pour abaisser ou relever les points, utiliser Increase height et saisir la valeur souhaitée. Exemple : -0.5 m pour abaisser la
sélection de 0,5 m ; 1.5 m pour relever la sélection de 1,5 m. Average height calcule l'altitude moyenne de la sélection.
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To delete points, you need to select them first.

Delete selected points either by clicking Delete selected button or use delete button on keyboard. Use Delete other
function to delete everything that is not selected. Use Undo or Redo function in case you change your mind.

6.6 Manipulate points (PH, S

Popup Manipulate points enables you to set height, increase height or compute average height of selected area. Select
desired area and click set height. Type desired new height and click OK. The selected points are moved accordingly.
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Page source 47 - suppression de points et accés a Manipulate points.
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In case you would like to lower or raise the selected points use increase height function and type the desired value. For
example, if you would like to lower the selected points for 0.5 meters type -0.5 m. If you would like to raise the selected
point to specific value, type for example 1.5m and click OK.

You can also compute the average height of selected points. Firstly, select the area of interest, go to Manipulate points

and click Average height.
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Page source 48 - modification ou calcul d’altitude moyenne.

6.7. Calcul de profils (PH, S)

La présentation de profils est fréquente, notamment sur les chantiers. Ouvrir 'onglet Point Cloud puis cliquer sur Calculer
profil. Les paramétres principaux sont définis dans la fenétre qui s’ouvre.

Consider point within distance, valeur par défaut 0,15 : distance de la zone tampon utilisée pour accrocher le profil
longitudinal au nuage de points.

Approximate segment length, valeur par défaut 0,15 : distance approximative entre points stationnés le long du profil
longitudinal.
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Calculate transverse profiles : active le calcul des profils transversaux.

Distance between transverse profiles, valeur par défaut 10 : distance entre deux profils transversaux le long du profil
longitudinal.

Length of transverse profile on each side, valeur par défaut 10 : largeur de chaque c6té du profil transversal.
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6.7 Calculating profile (PH, S)

It is often required, especially on construction sites, to present profiles. Open Point cloud tab and click Calculate profile.
Set the parameters in the pop-up:

Consider point within distance (.15 by default - distance of buffer zone for snapping longitudinal profile to PC,

Approximate segment length 0.75 by default - approximate stationary distance of longitudinal profile,

Calculate transverse profiles disabled by default - to set computation of transverse profiles,

Distance between transverse profiles J0 by default - stationary distance on longitudinal profile to compute transverse
profiles,

Length of transverse profile on each side 10 by default - width of either flank of transverse profile.

6.7.1. Longitudinal profile

To compute longitudinal profile, Calculate transverse profiles must be disabled. Click Select profile definition line to
define profile.

" Profile calculation X

ile defintion line From DXF Cancel
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Page source 49 - parametres de calcul des profils.

6.7.1. Profil longitudinal
Pour calculer uniquement un profil longitudinal, I'option Calculate transverse profiles doit étre désactivée. Cliquer sur Select
profile definition line pour définir le tracé du profil.
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Tracer la polyligne avec le bouton gauche de la souris, puis finaliser avec le bouton droit. Le profil calculé est affiché sur le

nuage de points, en 2D et en 3D, ou sur le maillage. Sur I'orthophoto, le profil apparait également sous forme de ligne de
repere.

Le profil longitudinal calculé est affiché dans le panneau de travail. Enregistrer le projet pour conserver les résultats.

STONEX

Left clicking the mouse, draw polygon, that defines longitudinal profile, ending it with a right mouse click.

Calculated profile, presented on orthophoto {green line)
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Page source 50 - tracé et affichage du profil longitudinal.
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Computed longitudinal profile is displayed in the working panel.

Save project to save results.

6.7.2 ransverse profiles

To compute transverse profile, calculate transverse profiles must be enabled. Click Select profile definition line to
define profile.

¥" Profile calculation X

Left clicking the mouse, draw polygon, that defines longitudinal profile, ending it with a right mouse click.
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Page source 51 - affichage du profil dans le panneau de travail.

6.7.2. Profils transversaux

Pour calculer des profils transversaux, I'option Calculate transverse profiles doit étre activée. Cliquer ensuite sur Select

profile definition line pour dessiner le profil longitudinal support.

Tracer la ligne de définition avec le bouton gauche, puis terminer avec le bouton droit. Aprés validation, les profils

transversaux sont générés le long du profil longitudinal.

Le profil défini peut étre consulté sur I'orthophoto, puis ouvert dans la fenétre Profile. Les profils transversaux s’affichent

sous le profil longitudinal, conformément a la liste présente dans le panneau de travail.
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Avec deux nuages de points issus de mesures réalisées a des dates différentes sur un chantier, les profils transversaux
permettent de visualiser les modifications du terrain entre les deux campagnes.

S
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Transverse profiles are displayed below longitudinal profile, as displayed on the list in the Working panel. If you wish to
view desired profile, you can zoom to it or dlick it on the list.
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Page source 52 - génération et affichage des profils transversaux.
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Using point clouds of two temporal measurements of construction site, you can observe reshaping of terrain, as presented
below. Transverse profile shows two profile points, which present two measurements.
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Page source 53 - comparaison temporelle de profils sur chantier.

6.7.3. Manipulation des profils
Les outils de manipulation des profils sont affichés en bas de la fenétre Profile.

Outil Fonction

Profile points Affiche les points du nuage détectés dans la zone tampon.
Profile lines Affiche les lignes définissant le profil.

Anchor points Affiche les points interpolés définissant la ligne de profil. Un

double-clic permet d’ajouter ou déplacer des points d’ancrage
pour mieux définir le profil.

Add Points / Added Points Permet de marquer des points et de modifier leur nom.
Reset view Réinitialise I'affichage pour voir I'ensemble des profils.
T=CH
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Reconnect Reconnecte la ligne de profil entre deux points d’ancrage
sélectionnés pour corriger une bosse, un objet non supprimé ou
remodeler localement le profil.

Delete Supprime le point d’ancrage sélectionné et reconnecte
automatiqguement les points voisins.

Export Exporte les profils en DXF, PDF ou formats CADdy .Ing / .que.

Vertical exaggeration Amplifie I'échelle verticale du profil.

Text size Reégle la taille du titre, des axes X/Y et du texte des points
ajoutés.

Pour remodeler une courbe ou un niveau, zoomer sur le profil transversal, sélectionner deux points extérieurs définissant la
forme souhaitée, puis cliquer sur Reconnect. Les points originaux du nuage restent visibles, mais la ligne de profil est
recalculée entre les points d’ancrage.

S
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>file manipulation

Profile manipulation buttons/tools are displayed on the bottom of the profile window.

*  Profile points show point cloud points detected in buffer zone.

Profile 1 (detance 3.00

*  Profile lines show lines that define profile.

rofile 1 (distance 6.00!

«  Anchor points show the interpolated point that defines the profile line. By double-clicking on the anchor point
line, anchor points can be added and moved to better define the profile.
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Page source 54 - points, lignes et points d’ancrage du profil.

S

STONEX

+  Reset view returns the view to all profiles.

*  Reconnect, reconnects profile line between two selected anchor points. When you have a bump or undeleted
object on top of the terrain, or if you would like ta reshape it. Here we have transversal profile computed across
construction machinery.

Ta shape it to preferable curve or level, zoom to transversal profile and click two external paints that present the desired
shape. Click Reconnect button and the transversal profile waill be reshaped. As you see, points that define transverse profile

remain present as profile points - the new shape is displayed below them.

Stenex Cube-3d - User Manual 55

Page source 55 - utilisation de Reconnect pour remodeler un profil.

T=CH4 \yAPS

Cube-3d - Manuel utilisateur FR | Source Stonex User Manual Ver. 4.0.1



STONEX

*  Delete deletes selected anchor point and automatically reconnects neighbouring points

*  Export, exports profiles between several possible formats: dxf, .pdf, CADdy profile format {.Ing, .que).

+  Vertical exaggeration slide bar allows you to extend vertical scale of profile.

*  Textsize:
Profile title, allows you to change scale of profile title.
Y - Axis, allows you to change scale on longitudinal axis.
X - Axis, allows you to change scale on vertical axis

Point text, allows you to modify text size of added points.
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Page source 56 - export, exagération verticale et tailles de texte.

6.8. Fusion de nuages de points (PH, S)

Si plusieurs nuages de points sont disponibles, ils peuvent étre fusionnés pour créer un nouveau nuage. Les deux nuages
doivent étre sélectionnés, puis I'utilisateur clique sur Merge. Le nouveau nuage apparait avec un nom composé a partir des
deux nuages d’origine.

6.9. Carte de couleurs / Colormap (PH, S)

Lors du traitement des nuages de points ou des DSM, les données peuvent étre affichées selon une échelle
hypsométrique. Cliquer sur Colormap pour choisir le type de rendu.

T=CH4 \yAPS

Cube-3d - Manuel utilisateur FR | Source Stonex User Manual Ver. 4.0.1



Pour un nuage photogrammeétrique, seul Height Map est disponible. Pour des scans laser, les options peuvent inclure
Elevation, Intensity, Scan Time ou Return data, selon les attributs enregistrés par le scanner.

Aprés sélection du champ, le modéle est colorisé selon I'attribut choisi et une Iégende est affichée. Un double-clic sur la
légende permet de la modifier.
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Profile 2

Point cloud merge (PH

If you have different point clouds you can merge them to a new point cloud. Both point clouds need to be selected. Click
Merge button to merge them into one.

6.9 Colormap (PH, S

When processing point clouds or DSMs, the data can be displayed in hypsometric scale. When displaying the desired data,
click on the Colormap button to select the type of display you want. If the cloud is photogrammetric, only the Height Map
will be present, while if you are using laser scanner scans you will be able to choose between Elevation, Intensity,Scan
Time or Return data (this field may be missing, depending on the data your scanner saves). Once you have chosen the
field, you will be able to view the coloured model according to the chosen feature with the accompanying scale and colour
legend. Double-click on the colour legend to change it.
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Page source 57 - fusion de nuages et Colormap.

Une plage personnalisée peut étre définie pour chaque Colormap. Faire un clic droit sur la Iégende, choisir Set range, puis
modifier les bornes dans la fenétre de réglage. Les parties situées hors plage sont alors affichées avec la texture originale.

Pour réinitialiser I'échelle, faire un clic droit sur la Iégende et choisir Reset range.
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Is possible to set custom range for each colormap. To change the range, right-click on the colour legend and choose set

range.

Now the widow for range settings will pop-up. Here you can modify the range.

Heightmap range X

Once you set the new range the visualization of the point cloud will change. The part of the point cloud out of the range

will be visualized with the onginal texture.
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Page source 58 - définition d’une plage personnalisée de Colormap.

6.10. Ombrage / Shading (PH, S)

L’'ombrage améliore la perception des caractéristiques spatiales des nuages et des maillages. Cliquer sur Shading pour
afficher les ombres sur les points du nuage. Cette option nécessite que les normales soient calculées ; si ce n'est pas le
cas, faire un clic droit sur le nom du nuage puis choisir Calculate normals.

6.11. Suppression d’un nuage (PH, S)

Cocher les données de nuage de points a supprimer de I'application, puis cliquer sur Delete.
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6.12. Génération de points CAD (PH, S)

Le générateur de points CAD permet d’extraire automatiquement des points selon une grille réguliére de taille définie,
directement exploitables dans les fonctions CAD.

Deux méthodes sont possibles : sélectionner une zone du nuage ou utiliser une fonction CAD pour dessiner un polygone
fermé. Dans le flux standard, sélectionner la zone de nuage souhaitée puis cliquer sur Generate CAD points.
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To reset the scale, right-click on the scale and choose reset range.

6.10. Shading (PH, S

For better perception of spatial charactenstics, point clouds, and meshes can be shaded Click on Shading button to display
shades on point cloud points. This option is available if the point cloud has normal calculated. If not calculated, right-click

on the point cloud name and click calculate normals.

6.11 Jelete (PH, S)
Tick point cloud data that you would like to delete from application and click delete button.

6.12. Generate CAD points (PH, S

Use CAD point generator and automatically extract points in regular grid of desired size, with CAD capabilities. You have 2
options, select desired area or use CAD function and draw closed polygon for selection. Here, we guide you through first

option.

Select desired area of point cloud, and click Generate CAD points function.
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Page source 59 - Shading, Delete et Generate CAD points.

T=CH4 \yAPS

Cube-3d - Manuel utilisateur FR | Source Stonex User Manual Ver. 4.0.1



Parameétres de génération CAD

e Point cloud : choix du nuage source dans la liste déroulante.

e Point classes : si une classification existe, choix des classes a exclure de la génération.
e CAD layer : couche CAD dans laquelle les points seront créés.

e Grid point spacing : espacement de la grille, valeur par défaut 5 m.

e Interpolation radius : rayon d’interpolation, valeur par défaut 0,15 m.

e Snap on lowest : extraction des points les plus bas uniquement.

Valider ensuite I'option de sélection souhaitée, par exemple From current selection. Les points CAD générés avec leur
altitude sont affichés dans le projet.

STONEX

Set parameters:
* Point cdloud: Choose from the drop-down menu the cloud from which to obtain points.

* Point classes: If you have made the classification, decide whether to delete certain classes from the generation

phase.
* CAD layer: Choose the CAD layer in which to create the points.
*  Grid point spacing: default 5Sm.
« Interpolation radius: default 0.15m.
*  Snap on lowest: Possibility to extract only the lowest points.

Confirm by selecting desired option of selection. In our case From current selection. Generated CAD points with displayed

height are presented.
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Page source 60 - parametres de génération de points CAD.

6.13. Réduction des nuages de points (PH, S)

La fonction Reduce point clouds permet de réduire le nombre de points sans relancer une reconstruction compléte.
Sélectionner le nuage concerné et saisir le nombre de points souhaité. La valeur saisie doit étre inférieure au nombre de
points du nuage d’origine. Un nouveau nuage est créé avec le suffixe -reduced.

6.14. Sauvegarde et export des nuages de points (PH, S)

Aprés avoir enregistré le projet, le nuage peut étre exporté depuis Point cloud -> Save as dans plusieurs formats :

*.ply : format Stanford mesh par défaut.

e *las/*.laz: formats laser et LiDAR.

e *7zlas : format LiDAR ESRI.

e *koo : fichier de coordonnées.

e *ixt/*.xyz: fichiers texte.

e *.csv/*.dsv: valeurs séparées par délimiteur.
e *pts:format PTS.

e *.cl3:format TOPCON LC3.

o *.e57:format ASTM E57.
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cing point clouds (PH, S)

Want to reduce point cloud paints, but don't want to process reconstruction again. Use Reduce point clouds function.

Define desired point cloud and set desired number of point cloud points. Typed value, that must be lower than onginal
point cloud. New point cloud appears with “-reduced” in the name.

6.14. Saving point clouds (PH, S)
Save project. You can export PC to - Select from dropdown list Point cloud -> Save as:

* ply - default Stanford mesh file

*las *laz - laser and LIDAR files

*zlas - LIDAR ESRI file

*koo ~ file of coordinates,

“txt - text file.

*xyz - text file

*csv *.dsv - delimiter-separated values format

*.pts - PTS format

*cl3 - TOPCON LC3 format

*e57 ~ ASTM ES7 format
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6.15. Calcul de la couleur d’un nuage a partir d'images photogrammeétriques (PH)

Cube-3d peut recalculer une texture couleur pour un nuage provenant d'un scanner laser ou d’une reconstruction
photogrammétrique, a partir d'images. La condition essentielle est que les images et le nuage soient dans le méme
systeme de référence.

Charger d’abord dans le logiciel le nuage de points a recoloriser. Charger ensuite les images dans Cube-3d, lancer le

Bundle Adjustment et créer au minimum un nuage clairsemé a partir de ces images.
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Si nécessaire, orienter le nuage clairsemé afin que I'ensemble des données soit cohérent dans le méme référentiel. Faire
ensuite un clic droit sur le nom du nuage de points et choisir Colorize. Le logiciel applique alors la couleur au nuage a partir
des images.
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6.15. Calculate point cloud colour from photogrammetry images (PH)

It is possible to recalculate a texture for a point cloud coming from laser scanner or from photogrammetry
using images. The important thing is that the images and the point cloud are in the same reference system.

First load the point cloud you want to retexture in the software. Second load images inside cube 3D.
Process the bundle adjustment and create at least a sparse point cloud from those images.

If needed perform the orientation for the sparse point cloud, so that everything is in the same reference
system.

Right-click on the pointcloud name and select colorize.

The software will start to apply the colour to the point cloud, based on the images.
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Page source 62 - recolorisation d’'un nuage de points a partir d’images.

6.16. Classification (PH, S)

Cliquer sur Classification pour classer les points terrain. La fenétre permet d’ajuster plusieurs paramétres qui contrélent la
reconnaissance du sol et le filtrage des objets hors sol.

e Terrain elevation : variation verticale brutale maximale acceptée dans le terrain.
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e Terrain slope : angle maximal entre I'horizon et la pente, en degrés.

e Minimal height : hauteur minimale des objets a supprimer.

e DSM cell size : taille de cellule du DSM précédemment calculé.

¢ Smoothing factor : niveau de lissage du terrain classifié.

e  Smoothing maximum size : taille maximale de la zone d’influence.

¢ Pointcloud from laser scanning (LiDAR) : applique un algorithme différent selon I'origine LiDAR ou photogrammétrique
des données.

Aprés définition des parametres, cliquer sur Continue. Dans I'écran suivant, sélectionner plusieurs portions clairement
identifiables comme du terrain. Ces zones sont agrandies selon les parameétres choisis, puis affichées en violet.
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6.16. Classification (PH, S)
Click Classification button to classify terrain points. In the pop-up window, you can adjust
e terrain elevation -maximal sudden elevation changes in terrain
* terrain slope ~maximal angle between horizon and slope in degrees,
« minimal height - minimal height of objects to be deleted,
e DSM cell size - cell size of previously computed DSM,
* smoothing factor - proportionate to smoothness of classified terrain.
* smoothing maximum size - maximal size of influential area

+ pointcloud from laser scanning (LIDAR) - applies a different algorithm depending on whether the data comes

from LIDAR or photogrammetry.

After setting the parameters click on Continue. You will arrive at a new screen. Here select certain portions of what is visually
recognisable as terrain. These will first be enlarged, based on the previously selected parameters, and finally displayed with
a violet colouring.

Stonex Cube-3d - User Manual &3
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Page source 63 - parametres de classification des points terrain.

Cliquer sur Continue pour que le logiciel affine la recherche des points a classer. Une seconde étape de classification
permet de corriger les zones mal classifiées si nécessaire. Si le résultat convient, cliquer sur Finish ; sinon, utiliser
Recalculate pour recommencer la procédure.

S

STONEX

Click on Continue to allow the software to refine the search for points to be classified. At this point you will move on to the
second classification step with which to further refine the classification, if you notice any parts of the terrain that are poorly
classified.

If you are satisfied with the result click Finish, otherwise click Recalculate to repeat the procedure.

Classification Parar

The Classification Tool in Cube-3d operates in two primary steps: 1. Marking the Points, and 2. Filtering the Points. This
guide explains the parameters involved in each step and their impact on the classification process.

1. List of Parameters

Terrain Elevation: Sets the allowable vertical difference when companng the elevation of neighboring cells. A higher
value allows more variation in elevation, enabling more points to be classified as part of the ground surface.

Terrain Slope: Defines the maximum slope angle difference between cells. A larger slope value allows steeper
vanations, allowing more points to be considered as ground surface.

Regular Grid Mesh Cell Size: Determines the size of each cell in the grid mesh. Smaller sizes capture more detail
but may require more processing time, while larger sizes process faster with less detail.

Smoothing Factor: Controls the amount of smoothing applied to the terrain data. Higher values create a smoother
surface by reducing small variations.

Smoothing Max Distance: Limits the distance over which smoothing is applied. This ensures that smoothing affects
only nearby points, preserving larger terrain features.

2. (Classification Process

The process of point classification is as follows:

Stonex Cube-3d - User Manual &4

Page source 64 - seconde étape de classification et guide des parametres.

Guide des paramétres de classification
L’outil de classification fonctionne en deux étapes principales : marquage des points, puis filtrage des points. Les
paramétres contrélent I'ampleur de la classification et la capacité du logiciel a distinguer le sol des objets.
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Terrain Elevation définit la différence verticale autorisée entre cellules voisines. Une valeur élevée accepte plus de
variation d’altitude et classe davantage de points comme surface de terrain.

Terrain Slope définit I'écart maximal d’angle de pente entre cellules. Une valeur élevée accepte des variations plus
abruptes et integre davantage de points au terrain.

Regular Grid Mesh Cell Size définit |a taille des cellules de la grille. Une petite taille capture plus de détails mais demande
plus de calcul ; une grande taille accélére le traitement mais simplifie le modéle.

Smoothing Factor régle le lissage appliqué aux données de terrain. Des valeurs élevées produisent une surface plus lisse
en réduisant les petites variations.

Smoothing Max Distance limite la distance sur laquelle le lissage s’applique, afin de préserver les grandes structures du
terrain.

Processus de classification

1. Sélection des parameétres : choisir Regular Grid Mesh Cell Size, Smoothing Factor et Smoothing Max Distance, puis
lancer le processus avec Next. Cube-3d crée automatiquement une grille réguliére qui organise les points pour le
traitement.

2. Sélection des régions de terrain : a I'étape Classification Step 1, sélectionner de grandes régions de terrain réparties
dans le nuage. Ces sélections aident le logiciel a identifier les surfaces principales. Les points sélectionnés sont affichés en
rouge comme points de terrain.

3. Filtrage : Cube-3d compare les cellules sélectionnées manuellement avec les cellules voisines a I'aide de Terrain
Elevation et Terrain Slope. Si I'écart d’altitude ou de pente dépasse les seuils, la cellule est exclue de la classification
terrain.
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1. Parameter Selection: First, select your classification parameters, including Regular Grid Mesh Cell Size,
Smoothing Factor, and Smoothing Max Distance. Once the parameters are set, initialise the process by clicking
Next. Upon initiation, a regular grid mesh is automatically created based on the selected parameters. This mesh
organises the point cloud data for efficient processing.

2. Terrain Region Selection: In Classification Step 1, you will be prompted to select some of the largest terrain
regions across different areas of the point cloud. This manual selection helps the software identify and classify
the main ground surfaces. The selected points are highlighted in RED to indicate they are classified as ground
surface points.

3. Point Filtering: The software filters points by comparing the manually selected cells with their neighbouring
cells using the Terrain Elevation and Terrain Slope parameters. If the elevation difference or slope angle exceeds
the specified thresholds for neighbouring cells, those cells are excluded from the ground surface classification.
Consequently, higher values for Terrain Elevation and Terrain Slope result in more points being included in the
ground surface classification.

3. Example

In the example below, there are two figures illustrating the effects of different classification settings.
Default Classification Settings

Figure 3a shows points marked and filtered using the default classification settings:

Terrain Elevation = 0.05 m

+  Terrain Slope = 18
Regular Grid Mesh Cell Size = 0.5 m
Smoothing Factor = 1

+  Smoothing Max Distance = 0.05m

- S =

Figure 1: Points marked and filtered by default classification settings

Increased Terrain Elevation and Slope
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Page source 65 - processus de classification et exemple avec parametres par défaut.

Effet des parameétres
Avec les parametres par défaut, I'exemple utilise Terrain Elevation = 0,05 m, Terrain Slope = 18°, Regular Grid Mesh Cell
Size = 0,5 m, Smoothing Factor = 1 et Smoothing Max Distance = 0,05 m.

En augmentant Terrain Elevation a 0,1 m et Terrain Slope a 26°, la surface marquée en rouge augmente : davantage de
points sont considérés comme terrain.

Un effet similaire peut étre obtenu en augmentant Smoothing Max Distance. Si I'écart entre I'approximation de la grille
réguliére et un point est inférieur a cette distance, le point est marqué comme terrain ; s’il est supérieur, il est exclu.
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Attention : une valeur excessive de Smoothing Max Distance peut conserver des éléments indésirables dans le terrain, par
exemple des pneus autour de véhicules ou les parties basses de murs de batiments. Le réglage doit donc équilibrer
réduction du bruit et préservation du terrain réel.
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Figure 3b displays the results obtained by increasing the values of Terrain Elevation and Terrain Slope. Evidently,
there is an increase in the size of the area marked in RED. The parameters used for this classification are:

Terrain Elevation = 0.1 m
Terrain Slope = 26
+  Regular Grid Mesh Cell Size = 0.5 m
Smoothing Factor = 1
Smoothing Max Distance = 0.05m

Figure 2: Points marked and filtered by increased values of Terrain Elevation and Terrain Slope

Effect of Smoothing Max Distance

A similar increase in the marked area can be achieved by adjusting the Smoothing Max Distance parameter, which
affects the classification as follows:

If the difference between the approximation of the regular grid mesh and a point is smaller than the
Smoothing Max Distance, the point is marked RED (as part of the ground surface) in the second step of
classification.

If the difference i1s bigger than the Smoothing Max Distance, the point is not marked.

For example, increasing the Smoothing Max Distance to 0.7 m will result in less points being filtered out during the
second classification step. However, this adjustment may lead to undesirable results, such as

+  Keptpoints Around Vehicles: Points representing details like tires around cars may remain in the point cloud
after classification.

Lower Parts of Building Walls: Paints in the lower sections of building walls might also remain, resulting in
less accurate classification.

Careful tuning of the Smoothing Max Distance is essential to balance between reducing noise and preserving
important terrain features.

Special Case: Stockpiles
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Page source 66 - augmentation Terrain Elevation / Terrain Slope et effet de Smoothing Max Distance.

Cas particulier : stocks et tas de matériaux

Lors de la classification de stocks ou tas de matériaux, les sommets peuvent ne pas étre intégrés a la surface terrain avec
les parametres par défaut. Cela peut fausser les calculs de volume.

Pour corriger ce comportement, réduire Regular Grid Mesh Cell Size et augmenter Smoothing Max Distance. Apres
sélection des grandes régions de terrain, les sommets des tas peuvent alors étre classés comme surface de terrain.
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Cette correction a un effet secondaire : certains objets non terrain peuvent étre intégrés par erreur, comme les pneus de
véhicules ou les bas de murs. Le contréle visuel aprés classification reste indispensable.
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When performing classification on stockpiles, there is a high chance that the tops of the stockpiles won't be included
in the terrain surface. In Figure 3, we used the default classification settings, and as a result, the tops of the stockpiles
were not included in the ground level. This can lead to inaccurate results when calculating volumes.

(b) Unassigned class - Default Classification Settings

Figure 3: Comparison of Classification Settings

To resolve this issue, we adjust the classification parameters by reducing the value of the Regular Grid Mesh Cell
Size and increasing the value of the Smoothing Max Distance. After selecting the largest terrain regions, you will
see that the tops of the stockpiles are now classified as ground surface (see Figure 4)

While these adjustments improve the inclusion of stockpile tops, they may also result in unwanted features being
classified as ground surface. Non-terrain elements like vehicle tires and the lower sections of building walls might be
incorrectly included.

The parameters used to include the tops of stockpiles in this case are:
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Page source 67 - cas des stocks avec parameétres par défaut.

Dans I'exemple amélioré, les paramétres utilisés sont Terrain Elevation = 0,05 m, Terrain Slope = 18°, Regular Grid Mesh
Cell Size = 0,25 m, Smoothing Factor = 1 et Smoothing Max Distance = 0,08 m.
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+  Terrain Elevation = 0.05 m

+  Terrain Slope = 18

+  Regular Grid Mesh Cell Size = 0.25 m
+  Smoothing Factor = 1

+ Smoothing Max Distance = 0.08 m

(a) Ground surface - Improved Classification Settings

(b) Unassigned class - Improved Classification Settings

Figure 4: Comparison of Classification Settings

This tool is used to extract layout and sections from the point cloud.

Is suggested to calculate first the normal of your point cloud. Right-click on the point cloud name and select Calculate
normals. For small projects as simplified size set 0, while for bigger projects you can increase this number.
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6.17. 2Dviews (S)

L’outil 2Dviews permet d’extraire des plans, vues et coupes a partir d’'un nuage de points.

Il est conseillé de calculer d’abord les normales du nuage : clic droit sur le nom du nuage, puis Calculate normals. Pour les
petits projets, régler Simplified size a 0 ; pour les projets plus volumineux, cette valeur peut étre augmentée.

Aprés calcul des normales, cliquer sur 2D views et sélectionner le nuage a utiliser. Pour un batiment unique, définir une
résolution cible d’environ 1 cm ; pour plusieurs batiments, 2 cm est généralement plus adapté. La transparence couleur
peut étre réglée entre 70 % et 90 %. Cliquer sur Generate pour produire les trois vues principales.
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After normal caleulations, click 20 views. Select the point cloud you want to use. As target resolution for ane single building
set 1 em, while for multiple buildings 2 cm. Colar transparency can be set between 70% and 90%.

Click generate to process the three prospective views,

In the 2Dviews page will be visualized three prospective views Top, Frant and Right. The available toals are:

. ﬂ Align model.

- ECalculate layout/section.
- ﬂ Draw Points.

»
. Draw Lines.
- Paint snapper setting, in order: on point, endpoint, middle point, nearest point.

Block the line drawing along the X and ¥ axis of the object.
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Outils disponibles dans 2Dviews

Align model : réaligner le modéle.

Calculate layout/section : calculer un plan ou une coupe.

Draw Points : dessiner des points CAD.

Draw Lines : dessiner des lignes CAD.

Point snapper setting : accrochage sur point, extrémité, milieu ou point le plus proche.
Blocage du dessin de lignes selon les axes X et Y de I'objet.

Vérifier d’abord I'alignement du nuage par rapport aux axes. Si nécessaire, sélectionner Align model, choisir un angle du
nuage puis dessiner le nouvel axe de référence. Les trois vues sont recalculées avec ce nouvel alignement.

Cliquer sur Calculate new layout/section pour dessiner une nouvelle coupe ou section. Partir de la vue Front ou Right pour
créer un plan ; partir de la vue Top pour créer une section verticale.

Dessiner a la souris la ligne rouge centrale de coupe, puis définir 'épaisseur de la section avec le périmétre de la zone
jaune. Les paramétres de résolution peuvent étre affichés avec Show more. Cliquer enfin sur Confirm pour calculer le plan
ou la coupe.
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First, check the alignment of the pointcloud respect the axis. If is necessary to align the madel to specific axis select the
Align model tool. Choose a corner of the pointcloud, and draw the new reference axis. The three views will be recalculated,

with the new alignment.

Click on the Calculate new layout/section button to draw a new cut or section. Start from the Front or Right view to create

a layout, while start from the Top view to create a vertical section.

Use the mouse to draw the red central line of the cut. Define the thickness of the section that will be used to calculate the
layout by choosing the perimeter of the yellow area. Is also possible to define the resolution parameters of the new layout
by clicking show more. Finally, click on Confirm to calculate the layout.
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Un clic droit sur le nom d’une vue, d’'un plan ou d’'une section permet de le recalculer ou de I'exporter. Les formats d’export
disponibles sont listés dans l'interface 2Dviews.

Avec Draw CAD points, I'utilisateur peut créer des points CAD directement depuis une section ou un plan. Le point
sélectionné est enregistré dans la couche active de la section CAD de Cube-3d.

Avec Draw CAD lines, il est possible de dessiner des lignes CAD directement sur une coupe ou un plan. Zoomer sur la
vue, cliquer les positions des points formant les vecteurs, puis terminer par clic droit. Les entités sont enregistrées dans la
couche CAD active et affichées avec la couleur de cette couche.
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Right-click on the name of a view/layout/section to recalculate or export it

2DViews - Export formats:

With the draw CAD points button, you can draw CAD points directly from a section or plan. After clicking, move the cursor
over the plan and select a point. This will be saved in the active layer in the CAD section of Cube-3D.

With the draw CAD lines button, you can draw CAD lines directly on a section or a layout. Zoom the layout and start drawing
by selecting positions of points that will create the vectors. When you want to end the drawing, right-click. This will be
saved in the active layer in the CAD section of Cube-3D. The colour visualized will be the same one as the CAD layer.
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Cube-3d peut également extraire automatiquement des vecteurs depuis un plan. Faire un clic droit sur le nom du plan, puis
choisir Detect lines. Une fenétre de paramétres s’ouvre.

Choisir la couche CAD dans laquelle les vecteurs seront créés. Le paramétre Threshold influence le nombre de lignes
extraites. Il est réglé automatiquement pour extraire environ 70 % des pixels blancs. Pour obtenir davantage de lignes,
réduire la valeur du seuil.

Les lignes créées peuvent ensuite étre complétées dans 2Dviews ou dans la section CAD.

T=CH4 \yAPS

Cube-3d - Manuel utilisateur FR | Source Stonex User Manual Ver. 4.0.1



STONEX

Is also possible to extract automatically vectors from layout.

Right-click on the layout name and select Detect lines. A parameter window will open. Choose the CAD layer where the
vectors will be created. The threshold parameter is related to the number of the lines extracted. It is set autoamtically by

the software to extract the 70% of the white pixels. If you need more lines reduce the threshold value.

Automatic line detection X

The software will create the lines. Is possibleto complete the lines drawing in the 2dviews or in the CAD section.

In Cube-3D is possible to load point clouds with panoramic images information already saved in them. The
supported format is the *.e57.
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6.18. Nuage de points avec images panoramiques (S)

Cube-3d peut charger des nuages de points contenant déja des informations d’images panoramiques. Le format pris en
charge est *.e57.

Lors du chargement du nuage, I'utilisateur peut choisir de charger ou non les images. Une fois les données chargées, des
bulles apparaissent a 'emplacement des images. La liste permet de gérer la visibilité de chaque bulle ou de toutes les
bulles.

Pour entrer dans une image panoramique, double-cliquer sur une bulle. L'image s’ouvre. Pour se déplacer dans I'image,
maintenir le clic gauche et déplacer la souris. La molette permet de zoomer ou dézoomer.

STONEX

When you load a point cloud you can choose f load the images or not.

¥ Lot et ot

Once loaded you will see some bubbles in the correspondence of the images, and on the list, you can
manage the visible bubble.

You can turn on off the bubbles and specific bubble.

To enter an image double click on one of the bubbles. The image will open. To move in the image, hold the
left mouse click and pan with the mouse. With the mouse gear you can zoom in an out of the image.
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Page source 73 - chargement des bulles panoramiques et navigation dans une image.

Pour passer a une autre image, double-cliquer sur une autre bulle. Les outils CAD sont utilisables directement dans les
images panoramiques : entrer dans la bulle, sélectionner I'outil CAD souhaité, puis commencer le dessin.

Raccourcis disponibles avec les images panoramiques : Shift + rotation de molette applique une transparence a I'image
pour voir le nuage de points situé dessous ; Ctrl + W quitte I'image panoramique courante.

STONEX

To switch to a different image, double click on another bubble.

On the images is possible to use the CAD tools. Enter the bubble, select the CAD tool of interest and start to
draw onit.

Shortcuts available when using panoramic images:
Shift + gear rotation: apply a transparency to the image to see the point cloud under it.

Ctrl+W: exit the current panoramic image.
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7. Manipulation des maillages (PH, S)

Les nuages de points peuvent étre représentés sous deux formes principales de maillages.

e DSM : modele numérique de surface construit a partir de points disposés sur une grille réguliére. Il ne représente pas
les surfaces en surplomb.

o Maillage 3D complet : maillage construit a partir de points en grille irréguliére. Il permet de représenter les surfaces en
surplomb.

7.1. Calculer un modeéle numérique de surface - DSM (PH, S)
Dans la liste déroulante, sélectionner Mesh -> Calculate new DSM, puis définir les paramétres de calcul.

Les paramétres par défaut sont les suivants :

e From point cloud : choisir le nuage de points a partir duquel le DSM sera généré.

e  Grid cell size : taille de cellule de la grille. La valeur par défaut correspond a la valeur optimale proposée par le logiciel.
¢ Hole-filling mode : méthode de comblement des trous, avec les options All, Optimise ou None.

¢ Smoothing size : nombre de cellules utilisées par le logiciel pour effectuer le calcul de lissage.

T=CH4 \yAPS

Cube-3d - Manuel utilisateur FR | Source Stonex User Manual Ver. 4.0.1



7. Mesh manipulation (PH, S)

Point clouds can be presented as 2 types of meshes:
* DSM, made from points in reqular grid, that don’t present overhanging surfaces.

o full 3D mesh, made from points in irregular grid, that present overhanging surfaces.

7.1 Calculate digital surface model (PH, S

Select from dropdown list Mesh -> Calculate new DSM and set parameters.

o Regular grid mesh calculation X

The default parameters are:
* From point doud: select the point cloud from which to derive the DSM.
*  Grid cell size: the default is the optimum value for the software.

* Hole-filling mode: choose between All, Optimise or None.

* Smoothing size: the number of cells on which the software will perform the chamfer calculation.

STONEX
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*.ply : format Stanford mesh par défaut.
*.dxf : format d’échange dessin DXF.
*.txt : fichier texte.
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Plus le parametre Smoothing size est élevé, plus la surface obtenue est lissée. La comparaison de trois DSM montre I'effet
du réglage : 10 cellules produit la surface la plus lisse, 5 cellules donne un lissage intermédiaire, et 1 cellule conserve le
plus de détails locaux.

Pour exporter les maillages calculés, il faut les enregistrer un par un. Afficher uniquement le maillage a sauvegarder, puis
sélectionner Mesh -> Save as.
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* koo : fichier de coordonnées.

* xyz : fichier texte XYZ.

*.stl : format stéréolithographie.

*.0bj : format Wavefront OBJ.

*.dae : format Khronos COLLADA.

*.xml : format de construction LandXML.

* tiff / *.tif : image TIFF géoréférencée, disponible uniquement pour les DSM.

STONEX

The higher the smoothing parameter, the smoother the surface will be. Comparison of three DSMs shows that higher
smoothing size gives smoothest surface. Selected models present the effect of three smoothing sizes:

« 10 cells (red) - the smoothest
*  5cells (purple) - semi-smooth

e 1 cells (blue) - the least smooth.

To export computed Meshes, you need to do it on at a time. First view just the one, you wish to save. Select from dropdown
list Mesh -> Save as.

o *ply - default Stanford mesh file

e *dxf - DXF drawing exchange format
e txt - text file

*  “koo - file of coordinates,

o Cxyz-text file,

e ‘*stl - stereolithography format,

*  *obj~ Wawefront OBJ format,

*  *dae - Khronos COLLADA format,

o *xml - landXML construction format,

o *.uff *tif - TIFF image format with georeferencing (only for DSMs)
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7.2. Calculer un maillage 3D texturé complet (PH, S)

Note : la texture est applicable uniquement aux modeéles issus de la photogrammeétrie. |l reste possible de calculer un maillage
3D complet a partir d’'un nuage LiDAR, mais sans texture photogrammétrique.

Dans la liste déroulante, sélectionner Mesh -> Calculate new Mesh, puis définir les parametres du maillage.
Les paramétres les plus courants sont :

e Calculation level : Medium par défaut.
¢ Maximal number of triangles : 2 000 000 par défaut.

e Le nombre maximal de triangles peut monter jusqu’a 10 000 000 pour produire un maillage 3D plus complet et plus
détaillé.

A nombre maximal de triangles identique, un niveau de calcul plus élevé produit une surface plus compléte et plus
détaillée. La comparaison montre quatre niveaux : Low, Medium, High et Extreme.

e Low : surface la plus lisse, sans arétes marquées.

¢  Medium : approximation lissée des arétes.

e High : arétes partiellement lissées.

e Extreme : arétes plus nettes, avec des surfaces a peine lissées.
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7.2.  Calculate texturized full 3D mesh (PH, 5)

* texture is only applicable for models obtained from photogrammetry. It is however possible to calcwlote o full 30 mesh from
o LIDAR point clowd,

Select from dropdawn list Mesh-> Calculate new Mesh and set parameters,

% Mesh calculation x|

Most commonly used, default parameters are:
*  Calculation level: Medium
*  Mammal number of tiangles: 2.000.000
+  The highest number of triangles can be set to 10.000.000 and allows you to make most completed 30 mesh.

Comparison of four Meshes shows that higher Celculation level gives completed - most detailed surface at the same

maximal number of triangles. Selected models present the effect of four calculation levels:
+  low ipurple) - the smoothest surface without edges
+  medium (blug) - smoothest approsmation of edges
+  high (turquoise} - half smoothed edges

*  extreme [green) - sharp edges with barely smoothed surfaces
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7.3. Drapage d’une orthophoto numérique (PH)
Pour améliorer la visualisation et la lecture spatiale du modele, plusieurs orthophotos peuvent étre plaquées sur plusieurs
DSM. Aller dans I'onglet Mesh, puis sélectionner Drape Orthophoto.

Définir la combinaison souhaitée entre orthophoto et DSM. Seuls les DSM peuvent étre utilisés pour le drapage. La
comparaison permet de visualiser la différence entre un maillage non texturé et un maillage texturé.

Lorsque 'orthophoto est plaquée sur le maillage régulier, la fonction Show texture devient disponible.
T=CH
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STONEX

7.3. Draping digital orthophoto (PH)

For better visualization and spatial presentation, multiple Orthophotos can be plastered on top of multiple DSMs. Go to
Mesh tab and select function Drape Orthophoto.

Set preferred combination of orthophoto and DSM. Remember, only DSM can be used for draping. Below is a comparison
between non-textured and textured mesh.

As orthophoto is plastered on top of reqular grid mesh, function Show texture becomes activated.
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Page source 79 - drapage d’une orthophoto sur un DSM.

7.4. Afficher la texture - Show texture (PH)

L’affichage d’'une orthophoto vraie ou traditionnelle plaquée sur un maillage 3D complet ou sur une grille réguliere peut
consommer beaucoup de mémoire.

La fonction Show texture permet d’activer ou de désactiver I'affichage de la texture. Un clic droit sur un maillage permet
aussi d’activer ou de désactiver la réduction de qualité de texture via Texture compression. Cette compression réduit
systématiquement I'utilisation de la mémoire.
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7.5. Afficher la grille - Show grid (PH, S)

Pour afficher la surface filaire d’'un DSM non drapé, cliquer sur le bouton Show grid.

S

STONEX

74 Show texture (PH
Viewing of plastering of true or traditional orthophoto on top of full 3D or regular grid mesh can be memory consuming.
Use Show texture function to manage texture-viewing ability.

By nght-clicking on a mesh, it is possible to activate or deactivate a reduction in texture quality by selecting “Texture
compression”. It always reduces the use of computer memory.

Show grid (PH, S)

If you want to see wire surface of undraped DSM, click Show grid button
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Page source 80 - Show texture, compression de texture et Show grid.

7.6. Affichage filaire seul - Wire only (PH, S)

Pour afficher uniqguement le filaire d'un DSM non drapé, cliquer sur Wire only.
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7.7. Aplatir - Flatten (PH, S)

Controler les objets que I'on souhaite filtrer du modéle. Sélectionner d’abord les masses reconnues qui s’étendent vers la
zone environnante avec une hauteur indésirable.

Utiliser ensuite la fonction Flatten pour éliminer ces masses et aplatir localement la surface.

STONEX

7.6. Wire only (PH, S)

If you want to see wire of undraped DSM, click Wire only button.

7.7 Flatten (PH, S)
Check for any objects that you would like to filter out of the model.

First select recognised masses extended to surrounding area with preferable height. To eliminate masses, use function
Flatten.
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Page source 81 - Wire only et utilisation de Flatten avant correction.
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After Flatten:

7.8. Volume calculation (PH, S)

Volume calculation based on interpolated surface: Calculate volume of matenal for single measurement - appropniate for
the calculation of dredged matenal.

How?

Calculate or load point cloud of selected area -> Click Mesh -> Calculate New DMS and set calculation parameters as
shown in Option settings Now you have two options for selecting area of interest:

1. Manual selection using the selection function.

Click on the Select button and select the area for volume calculation with a left mouse click. To end the
selection, click the right mouse button.

To calculate the volume on the selected area, click on Calculate Volume.
For the initial surface, use the default value Interpolate surface.
For the final surface, select: Calculated DSM.
Click on from current selection to calculate the volume of the selected area.
2. From a dxf file using the CAD functionality for repeated or detailed use:
To calculate the volume of the area, defined by the dxf boundary, click Calculate Volume.
For the initial surface, use the default value Interpolate surface.
For the final surface, select Calculated DSM.

Click From DXF and open the desired file.
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Page source 82 - résultat apres application de Flatten.

7.8. Calcul de volume (PH, S)

Le calcul de volume peut étre basé sur une surface interpolée. Ce mode permet de calculer le volume de matériau a partir
d’'une seule mesure ; il est adapté, par exemple, au calcul de matériaux excavés ou dragués.

Flux général : calculer ou charger le nuage de points de la zone, puis cliquer sur Mesh -> Calculate New DSM et régler les
paramétres du DSM.

Méthode 1 - sélection manuelle
e Cliquer sur Select et sélectionner la zone de calcul du volume avec le bouton gauche de la souris.
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e Terminer la sélection avec le bouton droit.

e Cliquer sur Calculate Volume.

e Pour la surface initiale, conserver la valeur par défaut Interpolate surface.

e Pour la surface finale, sélectionner Calculated DSM.

e  Cliquer sur From current selection pour calculer le volume sur la zone sélectionnée.

Méthode 2 - contour DXF via les fonctions CAD

e  Cliquer sur Calculate Volume pour calculer le volume de la zone définie par le contour DXF.
e Pour la surface initiale, conserver Interpolate surface.

e Pour la surface finale, sélectionner Calculated DSM.

e  Cliquer sur From DXF et ouvrir le fichier souhaité.

STONEX

After Flatten:

7.8. Volume calculation (PH, S)

Volume calculation based on interpolated surface: Calculate volume of matenal for single measurement - appropniate for
the calculation of dredged matenal.

How?

Calculate or load point cloud of selected area -> Click Mesh -> Calculate New DMS and set calculation parameters as
shown in Option settings .Now you have two options for selecting area of interest:

1. Manual selection using the selection function.

Click on the Select button and select the area for volume calculation with a left mouse click. To end the
selection, click the right mouse button.

To calculate the volume on the selected area, click on Calculate Volume.
For the initial surface, use the default value Interpolate surface.
For the final surface, select: Calculated DSM.
Click on from current selection to calculate the volume of the selected area.
2. From a dxf file using the CAD functionality for repeated or detailed use:
To calculate the volume of the area, defined by the dxf boundary, click Calculate Volume.
For the initial surface, use the default value Interpolate surface.
For the final surface, select Calculated DSM.

Click From DXF and open the desired file.
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Page source 82 - principes de calcul de volume sur surface interpolée.

Lors du calcul, la surface initiale est générée en premier a partir des points proches des bords de la sélection. Le volume
est ensuite obtenu par soustraction de deux surfaces.

Les résultats affichent les valeurs de la sélection courante et la somme totale de tous les volumes.

e  Fill : volume nécessaire pour combler les zones situées sous la surface moyenne.
e Cut: volume de matiére situé au-dessus de la surface moyenne.

e Total : somme des volumes Fill et Cut.

e Area 3D : surface tridimensionnelle de la zone sélectionnée.

e Area 2D : surface horizontale de la zone sélectionnée.

STONEX

When Calculate volume is in process, the initial surface will be generated first, based on points closer to the edges of
selections! Volume is calculated as subtraction of two surfaces.

Displayed results present values for both current volume selection and a total sum of all volumes, consisting of:
*  Fill - volume of needed mass to fill holes beneath mean surface.
*  Cut - volume of mass above mean surface
* Total - sum of filled and cut volume
*  Are 3D - three-dimensional area of selected surface

*  Area 2D - horizontal area of selected surface
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Page source 83 - résultat Fill / Cut / Total et surfaces 2D/3D.

Sélectionner Volumes dans le panneau de travail pour consulter tous les volumes calculés. Les zones de calcul
apparaissent comme des découpes du DSM drapé, chacune avec son propre titre. Si les courbes de niveau sont visibles,
leurs découpes sont également affichées.

Le calcul peut aussi étre basé sur deux mesures successives, cas idéal pour le suivi de chantier. Il permet de mesurer la
différence de volume entre deux campagnes de mesure.

Volume entre deux mesures successives

e Calculer ou charger les deux nuages de points correspondant a la zone a comparer.
e Créer les DSM associés via DSM -> Calculate New.

o Définir la zone d'intérét par sélection manuelle ou a partir d’'un fichier CAD/DXF.

e Pour la surface initiale, choisir le DSM initial.

e Pour la surface finale, choisir le DSM final.

e Lancer le calcul depuis la sélection courante ou depuis le contour CAD.
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Select Volume from the Working panel to observe all calculated volumes. Areas of volume calculation are presented as
cuts from draped DSM, each with its own title. If Contour lines are visible, their cuts are also presented. You can select,
deselect and remove selected volumes.

Volume calculation based on two consecutive measurements: |deal for monitoring on construction site. Measure the
volume difference between two consecutive measurements.

How?

Calculate or load two point clouds the area you would like to calculate -> Click DSM -> Calculate New and set DSM
calculation parameters as shown on the image below.

Now you have two options for selecting area of interest:

*  Manual selection of the calculation area using the selection function. Click on the Select button and select the
area for volume calculation with a left mouse click. To end the selection, click with the right mouse button. To
calculate the volume on the selected area, click on Calculate Volume. For the initial area, select the initial area for
the final area, select the final area Click on from current selection to calculate the volume of the selected area.
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Page source 84 - consultation des volumes et calcul entre deux mesures successives.

Les résultats présentent a nouveau Fill, Cut, Total, Area 3D et Area 2D pour la sélection courante ainsi que pour la somme
globale.

Pour supprimer un volume, ouvrir la page Volumes, sélectionner le volume concerné et appuyer sur Delete.
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*  Use a CAD .dxf file as a contour. To calculate the volume of the area defined by the .dxf boundary, click Calculate
Volume. For the initial surface, select the initial surface. For the final surface, select the final surface. Click From
CAD and open the desired file.

Displayed results present values for both current volume selection and a total sum of all volumes, consisting of:
*  Fill - volume of needed mass to fill holes beneath mean surface.
¢ Cut - volume of mass above mean surface.
* Total - sum of filled and cut volume.
*  Area 3D - three-dimensional area of selected surface.

*  Area 2D - horizontal area of selected surface.

To remove a volume, go to the Volumes page, select the volume to be deleted and press delete.
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Page source 85 - calcul de volume a partir d’un contour CAD et suppression d’un volume.

7.9. Calcul des courbes de niveau (PH, S)

Cliquer sur Calculate Contour lines. Dans la fenétre qui s’ouvre, définir I'équidistance souhaitée. Cocher Simplify si des
lignes plus lissées sont nécessaires.

Les courbes calculées sont affichées sur le DSM. Pour les exporter, aller dans I'onglet Contour lines du panneau de travail.

La hauteur des courbes peut étre affichée en cochant Show height. Un clic droit sur le nom des courbes permet de
simplifier a nouveau le résultat.
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L’export est disponible en DXF ou PDF. Une fenétre Save contour lines as DXF ou Save contour lines as PDF s’ouvre ;
saisir le nom du fichier puis cliquer sur Save. Le chemin du fichier exporté est ensuite affiché.

S

STONEX

Calculate contour lines (PH, S

Click button Calculate Contour lines. Select desired equidistance in the pop-up window. Check simplify if more smoothed

lines are needed.

Cakulate contour lines x

Calculated contour lines are displayed on the DSM. To export, go to Contour lines tab in Working panel

Contour lines’ height can be displayed by checking Show height box. If you right dlick on the contour line name, is possible
to simplify again the result. To export contour lines, choose between *.DXF and *.PDF data types. A new window, titled
Save contour lines as DXF or Save contour lines as PDF, pops up. Enter desired file name and click save. New window

with exported file path pops up.
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Page source 86 - génération, affichage et export des courbes de niveau.

7.10. Projection CAD sur maillage (PH, S)
Si les couches CAD importées dans le logiciel ne possédent pas l'information altimétrique correcte, elles peuvent étre
projetées sur un maillage.
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Faire un clic droit sur le nom du maillage puis sélectionner Project CAD on mesh. Choisir les couches a projeter, ainsi que
le mode d’accrochage des sommets sur le maillage : point le plus bas ou point le plus haut. Aprés projection, les points se
superposent au maillage.

S

STONEX

’10. CAD projections on mesh (PH, S

If the CAD layers imported in the software does not have the correct height information, is possible to
project them on a mesh. Right-click on the mesh name and select Project CAD on mesh.

You can choose the layers to be projected, and how to snap the vertex on the mesh if on lowest or highest
point. After the projection the points will be overlapped with the mesh.
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Page source 87 - projection de couches CAD sur un maillage.

7.11. Supprimer un maillage (PH, S)

Cocher les données Mesh a supprimer de I'application, puis cliquer sur Delete.
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¥ Project CAD shements to mesh x

7.11. Delete (PH, S)

Tick Mesh data, you would like to delete from application and click delete button.
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Page source 88 - suppression de données Mesh.

8. Orthophoto numérique (PH, S)

Cube-3d permet de calculer deux types d’orthophotos.

e Orthophoto originale : basée sur un maillage régulier.
e True orthophoto : basée sur un maillage 3D complet en grille irréguliére.
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8.1. Calcul d’'une orthophoto numérique vue du dessus (PH)
Dans la liste déroulante, sélectionner Orthophoto -> Calculate new.

Définir les parameétres dans la fenétre Digital Orthophoto Calculation. Commencer par Desired resolution. Comme la valeur
saisie peut ne pas étre calculable exactement, Actual resolution indique la résolution effectivement disponible la plus
proche. Cette valeur dépend de la résolution souhaitée et de la taille de cellule du DSM sélectionné.

Cliquer sur More pour afficher I'option Split DOF. La valeur par défaut Tile maximum size est 20 000, ce qui signifie que le
DOF sera découpé s'il dépasse 20 000 pixels. Une fois les paramétres définis, cliquer sur Calculate.

Toutes les orthophotos calculées sont affichées dans le panneau Orthophoto.

STONEX
8. Digital orthophoto (PH, S)

Cube-3d offers computation of two types of orthophoto:
« original orthophoto based on regularly gridded mesh

* true orthophoto based on irregularly gridded full 3D mesh

8.1 Digital orthophoto calculation top-down (PH)

Select from dropdown list Orthophoto -> Calculate new.

Set parameters in a Digital Orthophoto Calculation pop-up. First, set Desired resolution. As entered value may not be
possible to compute, Actual resolution is presented below to inform you about the closest available result. It is an outcome
of entered desired resolution and DSM cell size based on selected DSM. Click more to check the split DOF box. Default Tile
maximum size is set to 20.000, meaning DOF will be split if it exceeds 20.000 pixels. When set, click Calculate.

In the panel called orthophoto, will be visualized all the calculated orthophotos.
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Page source 89 - calcul d’une orthophoto et paramétres de résolution.

Pour enregistrer I'orthophoto, cliquer sur Export puis choisir PDF ou image. Les formats image disponibles sont les
suivants :

e *jpg/*.jpeg avec fichier *.jgw.
o *.tif / *.tiff avec fichier *.tfw.
e *.png avec fichier *.pgw.

Que l'export soit réalisé en image ou en PDF, il est possible de définir la zone a sauvegarder, d’inclure des mesures
comme les volumes ou les profils, et de régler les parameétres propres au format de sortie.

S
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To save the orthophoto, click on Export and choose between PDF or image. The following formats are available as images
JPg “jpeg + “Jgw

“tif “tiff + “tfw

*png + *.pgw

Whether you export as an image or, as a PDF, you can decide the area to be saved, whether to include measurements, such
as volumes or profiles, as well as having specific parameters depending on the output format.
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Page source 90 - export d’orthophoto en image ou PDF.

8.2. Corrections d’orthophoto numérique (PH)

Pour calculer une orthophoto numérique, suivre le flux complet de calcul décrit précédemment. Si le résultat n’est pas
satisfaisant, les outils de correction permettent de I'améliorer.

Avec une altitude de vol faible, des artefacts peuvent apparaitre sur les toitures. lls peuvent étre corrigés avec I'outil
Recalculate orthophoto.

Point critique : charger simplement une orthophoto dans Cube-3d ne suffit pas pour utiliser Recalculate orthophoto. Il faut
avoir réalisé le processus complet de calcul d’orthophoto dans le projet.

Lorsque I'orthophoto est calculée, sélectionner les zones a recalculer. Utiliser Select et sélectionner les images préférées.

L’assistant de sélection d'images affiche les images couvrant la zone sélectionnée. Choisir 'image a utiliser pour le
recalcul puis cliquer sur Confirm.
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8.2. Digital orthophoto corrections (PH)

To calculate digital Orthophoto follow steps from 1 to 11 (page 2- 21). If you are not satisfied with results, you can use
correction tools to improve them. Because of low flight altitude, often artefacts on roofs of the houses will appear. You
can easily correct them with Recalculation orthophoto tool.

Note: Simply loading your Orthophoto into Cube-3d is not enough for Recalculate orthophoto function. To be able to
recalculate, one needs to go through the whole process for orthophoto calculation.

How?

When your Orthophoto is calculated, select the areas you would like to recalculate. Use Select button and select preferred
images.

Wizard for image selection, with images of selected area will appear - select the image you would like to use for
recalculation and click Confirm.
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Page source 91 - sélection des zones et images pour recalcul d’orthophoto.

En présence d’artefacts supplémentaires, répéter le processus pour sélectionner toutes les zones concernées. Une fois les
sélections terminées, cliquer sur Recalculate orthophoto.

Le résultat permet de remplacer localement les zones dégradées par une image mieux adaptée.
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In case of additional artefacts repeat the same process to select all the areas. When you are finished with selecting click
Recalculate orthophoto button

Results:

Before After
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Page source 92 - recalcul local et résultat avant / apres.

8.3. Découper une orthophoto (PH, S)

Il est possible de découper une zone spécifique du DOF et de I'enregistrer comme nouvelle orthophoto. Cliquer sur Cut.

Sélectionner la zone souhaitée : clic gauche pour démarrer le rectangle, puis glisser la souris pour couvrir la zone. Les
coordonnées et I'emprise du rectangle sont visibles en bas a gauche.

Une fois la zone d’intérét sélectionnée, cliquer sur Confirm pour calculer la découpe.
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8.4. Fusionner des orthophotos (PH, S)

La fonction Merge fusionne deux orthophotos. Elles n’ont pas besoin de se recouvrir ni méme d’étre contigués.

Charger ou sélectionner les orthophotos souhaitées, puis cliquer sur Merge.

)

STONEX

Select desired area. Left mouse click to start drawing rectangle and drag mouse to select rectangle over desired area. You

can observe coordinate values in left bottom corner and coordinate range of selected rectangle.

When area of interest is selected, click confirm to calculate the orthophoto cut.

84. Merge orthophoto (PH, S
Merge is a function that merges two orthophotos that don't need to overlap or even converge.

Load or select desired orthophotos and dick Merge.
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Page source 93 - découpe et lancement de la fusion d’orthophotos.

Dans la fenétre qui s’ouvre, sélectionner la zone a fusionner. Cliquer a une extrémité puis définir le rectangle sur la zone
d’intérét. Cliquer sur Next.
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En cliquant sur une orthophoto dans la partie droite, celle-ci s’affiche. La commande Select area to merge permet de
choisir une zone spécifique. Cliquer ensuite sur Paste orthophoto pour coller la partie sélectionnée dans la nouvelle
orthophoto.

Sélectionner 'orthophoto suivante dans la liste pour régler sa transparence avec Alpha. Définir la zone souhaitée sur la
deuxiéme image ; le réglage Alpha permet de visualiser les limites de fusion.

Blending Size permet de lisser les bords entre les parties superposées. Une fois toutes les parties fusionnées, cliquer sur
Finish. La nouvelle orthophoto merged est affichée.

S
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In a pop-up window, select the area you want to merge. Left click on one end and set the rectangle across interested area
Click Next.

If you click on an orthophoto on the right side, it will be displayed. You can select a specific area of the orthophoto with
the select area to merge command. Click on the Paste orthophoto button to paste the selected part onto the new
orthophoto. Click on the next orthophoto in the list to set its transparency by adjusting Alpha. Select the desired area on
the second image - the Alpha adjustment shows the merging boundaries. The Blending Size allows you to smooth the
edges between the overlapping parts. When all parts are merged, click on Finish.

When the merging finishes, the new orthophoto (merged) is displayed.
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Page source 94 - zone de fusion, transparence Alpha et Blending Size.

T=CH4 \yAPS

Cube-3d - Manuel utilisateur FR | Source Stonex User Manual Ver. 4.0.1



8.5. Calculer une surface (PH, S)

Cliquer sur Calculate area pour calculer une surface sur I'orthophoto. Définir la zone par un polygone : clic gauche pour
placer les sommets, clic droit pour fermer le polygone.

Le résultat affiche :

e Area: surface planimétrique de la zone sélectionnée.
o Perimeter : périmétre de la zone sélectionnée ou longueur du polygone.

8.6. Supprimer une orthophoto (PH, S)

Cocher les données DOF a supprimer de I'application, puis cliquer sur Delete.

8.7. Orthophoto depuis un nuage de points (PH, S)

Pour créer une orthophoto a partir d’'un nuage de points, sélectionner le type d’orthophoto souhaité : vue du dessus ou plan
personnalisé.

Définir le plan si nécessaire, régler la résolution souhaitée, puis cliquer sur Calculate. Le systéme calcule alors une
orthophoto sur le nuage de points sélectionné.
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85 Calculate area (PH, S)

Click Calculate area button to compute area on the orthophoto. Select area with polygon using left mouse click to
determine points and right one to close it. Area result, will popup:

*  Area - planimetric area of selected region,

*  Perimeter - circumference of selected region or length of polygon

8.6 Delete (PH, S)

Tick DOF data, you would like to delete from application and click delete button.

8.7 Orto

to from a pointcloud (PH, S)

To create an orthophoto from a point cloud, select the desired orthophoto type, between top-down and custom plane.
Select the plane if necessary and set the desired resolution. Click on calculate and the system will calculate an orthophoto
on the selected point cloud.

photo Calculamon
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Page source 95 - calcul de surface, suppression DOF et orthophoto depuis nuage de points.
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9. Fonctions CAD (PH, S)

Les fonctions CAD permettent de dessiner directement sur un nuage de points, un maillage, une orthophoto ou une scéne 3D.
Les entités créées peuvent ensuite étre exploitées dans des logiciels de DAO/CAO.

Dans le panneau de travail, ouvrir 'onglet CAD. La barre d’outils regroupe notamment les outils d’édition, de sélection, de ligne,
de cercle, de mesure et de dessin. La liste des couches CAD affiche, pour chaque couche, son état de sélection, de visibilité, de
verrouillage, son nom, sa couleur et son épaisseur de ligne.

9.1. Préparer les couches (PH, S)

e  Cliquer sur + pour créer une nouvelle couche.

e Double-cliquer sur le nom pour le modifier, puis appuyer sur Entrée pour valider.

o Double-cliquer sur le carré de couleur pour changer la couleur de la couche.

o Double-cliquer sur I'épaisseur de ligne pour saisir une nouvelle valeur.

e Utiliser les icones de visibilité, de sélection et de verrouillage pour controler I'état de chaque couche.

9.2. Outil de sélection (PH, S)

L’outil Select permet de sélectionner plusieurs objets CAD dessinés. Le sens de sélection modifie le comportement.

e  Sélection de droite vers gauche : tous les objets partiellement inclus dans la fenétre sont sélectionnés.
e  Sélection de gauche vers droite : seuls les objets entierement inclus dans la fenétre sont sélectionnés.

9.3. Dessiner un point (PH, S)

Sélectionner la couche souhaitée, puis choisir I'outil Draw point. Régler ensuite les options d’accrochage et d’affichage dans
Snapper settings et Tool settings.

Point snapper : accrochage direct sur un point du nuage.

Accrochage possible sur extrémités, milieux, lignes existantes ou a proximité d’une ligne.
Chaque point peut afficher un nom, une altitude et un code.

La taille du texte et la valeur du code peuvent étre personnalisées.
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9. CAD Functionalities (PH, S)

There comes a need, when you wish to draw on your point cloud. Draw objects entities that could further be used in
Computer aided design (CAD) programs. In working panel tab CAD. At the top is a working panel tool bar, with edit tool,
selecting tool, draw line tool and draw circle tool. You can check all layers in the layer list on working panel. Each layer
has its attributes (whether it’s sel d, visible or locked), name, colour and line weight

9.1 Preparing layers (PH, S)

As all CAD applications tent to use layers, it is useful, if you first make new layers, assign their colour and line width. Click
+ to make new layer. To change name, double click it. Pres enter to confirm. Double click on colour square, to change the
colour. Change line weight by double clicking on number. Type new weight. Those layers that are visible, have a scheme

L0

in the second row, as oppose to nonvisible ones ® . At the time, only one layer can be selected, in the second row

¢ is visible, as oppose to all the others& . Third row shows whether layer is locked a or unlocked a .To change
any of layers attributes, click on unwanted scheme in desired row of layer.

9.2. Select tool (PH, S)

Use select taol % to select multiple drawn CAD objects. By selecting from left to right, you can select different points.
* when you draw selection from right to left, all objects, of which parts were inside selection are selected.

*  when you draw selection from left to right, you will select only those objects, of which all parts are being selected.

9.3 Draw point (PH, S)

To draw set the desired layer and select draw point taol '~ . Go to

PP ings and tool ings to select type of

snapping and display settings. If you want to snap directly on point cloud point, select point snapper. This option
supports also snapping on endpoints, midpoints and on or near existing lines. Each point can have displayed name, height
and code. Size of displayed text and code value can be specified.
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Page source 96 - couches CAD, outil de sélection et dessin de points.

9.4. Dessiner une ligne (PH, S)

Sélectionner la couche souhaitée, puis I'outil Draw line. Définir le type d’accrochage et les mesures a afficher.

Le dessin peut s’appuyer directement sur les points du nuage ou créer de nouveaux points interpolés lorsque le point exact
n’existe pas dans le nuage.

e Avec Point snapper, la ligne s’accroche aux points du nuage, aux extrémités, aux milieux et aux lignes existantes.

e Avec Interpolate points, Cube-3d calcule une altitude moyenne dans un rayon défini autour du curseur. Au moins un point du
nuage doit étre présent dans le cercle bleu.
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e La section Show permet de choisir les informations affichées pendant le dessin.

Pour dessiner, cliquer avec le bouton gauche pour placer les sommets. Backspace supprime le dernier point, Escape annule le
dessin, et un clic droit termine la polyligne.

STONEX

94 Draw line (PH, S)

B

To draw set the desired layer and select draw line tool % Second, click on snapper settings to select type of snapping
and measurements display. If you want to snap directly on point cloud point, select point snapper. This option supports
also snapping on endpoints, midpoints and on or near existing lines.

2nd option is to draw the line by creating new points - this option is useful in case you don't have a certain point cloud
point to draw on - in this case interpolate points and select desired radius of point snapper to define the average height
(at least one point of the point cloud needs to be in the blue circle) of the new point which will be created in the centre of
the mouse cross. You can select different parameters to be shown in the drawing in the Show section.

Start drawing lines, using left mouse click. If you mis-clicked use backspace, to delete last point. Abort drawing at any point
with escape button. End drawing pofygon of lines using right mouse click.
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Page source 97 - dessin de lignes, accrochage et interpolation de points.

Pour terminer une polyligne sur un point déja dessiné, activer Element snapper et approcher le curseur du point voulu. L’élément

détecté se met en évidence ; cliquer avec le bouton gauche pour s’y accrocher. Les réglages d’accrochage peuvent étre modifiés
pendant le dessin.
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9.5. Dessiner un cercle (PH, S)

Sélectionner Draw circle et la couche souhaitée. Choisir le type d’accrochage et la zone de snap. Cliquer pour définir le point de
base du cercle, déplacer la souris pour définir le diameétre, puis confirmer par un clic gauche. Le clic droit ou Escape annule
I'opération.

STONEX

If you want to end drawing polygon on already drawn point, select to use element snapper an approach desired point
with your cursor. As snapper is active, already drawn element/elements will mark. Click at desired paint with left mouse
click and continue to draw. You can change snapper settings while drawing CAD objects.

9.5. Draw circle (PH, S)

Cs)
To draw a circle, select draw circle tool (') and desired layer. Select type of snapping, and snapping zone. Left click circles
base point, drag mouse to assign diameter, confirm with left mouse click. Use nght mouse click as well as escape button to
abort drawang.
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Page source 98 - fermeture de polyligne par accrochage et dessin de cercles.

9.6. Outil de mesure (PH, S)

Sélectionner la couche souhaitée, puis Measure tool. Choisir le type d’accrochage dans Snapper settings. Cliquer sur le premier
point, puis sur le second point de la mesure.
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e Distance 2D ou 3D.

e Pente.
o Différence d'altitude - Delta Height.
e Azimut.

e Mesure de surface via I'option Measure Area accessible depuis la fleche de l'outil.

Measure Area permet de mesurer des surfaces 2D et 3D. Activer le mode souhaité, ou les deux, avant de lancer la mesure.

STONEX
9.6 Measure tool (PH, S)

To measure set the desired layer and select measure tool Q . Second, click on snapper settings to select type of
snapping. If you want to snap directly on point cloud point, select point snapper. This option supports also snapping on
endpoints, midpoints and on or near existing lines. Left mouse click on the first end of measurement and then on second.
You can select the type of measurement to show between distance (2D or 3D), slope, elevation difference (AHeight) or
azimuth. Click esc to exit or continue measuring.

There is also the possibility to convert the measure tool into the *“Measure Area” tool by clicking on the arrow next to the
symbol, then selecting the corresponding option. The tool can measure 2D and 3D areas, be sure to toggle the desired
one, or both.
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9.7. Outil d’édition (PH, S)
Sélectionner Edit tool, approcher le curseur de I'objet voulu, puis cliquer lorsqu’il est mis en évidence. Il est possible de déplacer,
redessiner ou supprimer des points et objets sélectionnés.

e Select similar : sélectionner les objets CAD similaires sur toutes les couches.

e Select similar on same layer : sélectionner les objets CAD similaires uniquement sur la couche active.

e Lafenétre Element properties affiche les propriétés de I'objet ou de la couche : couleur, type de ligne et couche
d’appartenance peuvent y étre modifiés.

9.8. Outil de dessin CAD assisté par photo (PH)

Cet outil permet de dessiner directement sur les images afin d’améliorer la précision de sélection des points. Il fonctionne
directement sur le nuage clairsemé, sans obligation de reconstruire le nuage dense. Le dessin surimage est souvent plus lisible
que le dessin sur maillage.

Sélectionner une couche CAD, puis commencer a sélectionner un point. Le menu de dessin photo apparait a gauche de I'écran.
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9.7 Edit tool (PH, S)

O .
To edit drowning, select edit tool "7 and get close to desired objects. When marked, select it with left mouse click. You
can move, redraw or delete selected points or objects. Click on the drop down button of edit tool and click on:

e select similar to select same CAD object drawn on all layers.

* select similar on same layer to select all CAD objects on layer of selected object

All data of selected object or layer are displayed in Element properties vandow of working panel. There you can change
its colour, line type or layer by clicking on desired attribute and change it from available possibilities.

9.8 Photo-assisted CAD drawinc

Draw with CAD tools directly on images, for more precise point selection, directly on the sparse point cloud (no need to
reconstruct the dense point cloud!). It is also easier than drawing on a mesh

Select a CAD layer and start selecting a point; the photo drawing menu will appear on the left-hand side of the screen
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Page source 100 - édition CAD et lancement du dessin assisté par photo.
Le curseur permet de régler le zoom des images. Les icones de grille définissent le nombre de photos affichées simultanément.

Utiliser les différentes vues photographiques pour positionner précisément le curseur sur le point voulu. Lorsque I'on sélectionne
un point dans la scene 3D, les images offrant la perspective la plus proche du point de vue actuel s’affichent en premier.
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Use the photos to position the cursor on the desired point, using the different angles to ensure that the selected position
is the correct one.

When selecting a point on the 3D scene, the images with the closest perspective to the viewing position are displayed
first.

Stonex Cube-3d - User Manual 101

Page source 101 - choix du nombre d’images, zoom et sélection multi-vues.

9.9. Dessiner avec saisie de longueur (PH, S)

Les lignes peuvent étre dessinées en saisissant directement la longueur souhaitée pendant la numérisation. Commencer une
ligne, saisir la longueur du segment, puis orienter le segment avec le curseur. Si Object UCS est actif, la direction respecte les

axes UCS définis.

9.10. Trim, Extend et Intersect (PH, S)
Les outils Trim, Extend et Intersect accélérent les opérations de nettoyage CAD, d’intersection précise et d’accrochage, afin de
produire des dessins plus propres.
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Trim tool
Activer Trim tool, puis cliquer sur le segment a tronquer. Le segment est déterminé par ses sommets.

S

STONEX

). Draw with Length Output (PH, S

Lines can now be drawn by directly entering the desired length during digitisation. Start to draw a line, then simply

digitise the length of the segment. The line will be drawn in the direction described by the cursor, or according to the
directions of UCS, if active

).10. Trim, Extend, and Intersect (PH, S)

Trim, Extend, and Intersect tools streamline CAD editing operations. They allow faster cleanup, precise line intersections,
and improved snapping — resulting in cleaner and more professional drawings.

Trim tool

Enable the trim tool, then click on the segment that you want to trim. The segment is defined by its vertices.
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Page source 102 - dessin par longueur saisie et outil Trim.

Extend tool
Extend tool prolonge une ligne dans sa direction jusqu’a I'accrocher a la ligne la plus proche. Cliquer sur I'outil, survoler la ligne a
prolonger, vérifier I'apercu en ligne noire, puis cliquer pour confirmer.
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Result after the trim

Extend tool

The extend tool allows you to extend the selected line along its direction and snap it to the nearest line. Click on the tool
button, then move your mouse on the line you would like to extend. A subtle black line will indicate the extension’s
preview. Click on the line to confirm the operation.
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Page source 103 - résultat Trim et prévisualisation Extend.

Intersect tool

Intersect tool prolonge deux segments jusqu’a leur point d’intersection. Sélectionner I'outil, cliquer sur la premiére ligne, puis sur la
deuxieme.
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Result after extension:

Intersect tool

The intersect tool allows you to extend two segments to the point where they meet. Select the tool button, then dick the

first line, then the second.
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Page source 104 - résultat Extend et principe de Intersect.

9.11. Dessiner sur des plans (PH, S)

Pour fiabiliser les dessins CAD, il est possible de définir un plan personnalisé et de verrouiller les futurs dessins sur ce plan.

Cliquer sur Define Plane, puis sélectionner au moins un point pour définir le plan. Un plan jaune est identifié. Plus le plan est
complexe, plus il faut de points pour le définir. Pour un plan vertical, trois points minimum sont nécessaires. Une fois la définition
terminée, cliquer sur Confirm plane : le plan devient bleu.
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Draw on planes (PH, S

To improve the CAD drawings is possible to set a custom plane to be able to lock all the drawings to be in the same
plane.

First click on Define Plane and select at least one point to define the plane. A yellow plane will be identified. The more
complex is the plane the more pints will be needed to define it. To define a vertical plane, you need at least three points.
Once the plane definition is done, click Confirm plane. The plane will become blue.
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Page source 105 - définition d’un plan de dessin CAD.

A partir de ce moment, les points ou vecteurs dessinés sont projetés sur le plan. Une fois le plan défini, Object UCS permet de
verrouiller la direction des vecteurs dans les directions perpendiculaires au dernier vecteur dessiné.

Cet outil est particulierement utile en combinaison avec Top down view et Ortho mode pour dessiner des plans de sols, des
fagcades ou des périmétres de batiments.
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From now on all the points or vectors you are drawing will be projected on the plane.

Once a plane is defined, is also possible to lack the direction of the vector. By clicking Object UCS the vector will be
created only in the perpendicular directions of the last vector drawn.

The tool is good to be used in combination with the Top down view and the Ortho mode render of the point cloud. In
this visualization from top is possible to easily draw floor plans or perimeter of buildings.
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La définition de plan peut aussi étre utilisée avec les images panoramiques : définir d’abord le plan, entrer ensuite dans I'image
panoramique et commencer le dessin. Cette méthode améliore la précision des tracés.

Raccourcis clavier : maintenir Q crée un plan local basé sur la hauteur du point sélectionné ; relacher Q réinitialise le plan. F8
active ou désactive Object UCS.

9.12. Accrochage perpendiculaire (PH, S)

Perpendicular Snap aligne automatiquement les éléments a angle droit. Activer I'accrochage, commencer une ligne, puis utiliser
le symbole noir indiquant la perpendicularité par rapport a une ligne proche.
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The plane definition of plane can also be used in combination with panoramic images. First create the plane, second
enter in the panoramic image and start to draw. This will improve the accuracy of the drawing.

There are two shortcuts in the keyboard that can be used when dealing with planes.

Hold on Q: will create a local plane based on the height of the point you are selecting. If the Q is not hold the plane will
be resetted.

Press F8: vall turn on and turn off the Object UCS tool.

9.12. Perpendicular Snap (PH, S)

The Perpendicular Snap automatically aligns elements at right angles. Activate the snap, then start to draw a line. The
snap will indicate the perpendiculanty to a line close by with a black symbol.
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9.13. Perpendiculaire 3D (PH, S)

3D Perpendicular permet d’étendre des dessins 2D en filaires 3D précis. Activer Perpendicular Snap et Object UCS, puis dessiner
une ligne depuis le sommet d’une ligne existante. Le symbole noir confirme la perpendicularité.

9.14. Découpe par CAD - Clipping with CAD (PH, S)
Il est possible de découper des nuages de points, des maillages et des orthophotos a partir d’'un polygone CAD. Le polygone peut
étre dessiné dans Cube-3d ou importé depuis un autre logiciel.
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Aprés avoir dessiné la ligne, sélectionner I'élément & découper, faire un clic droit et choisir Clip. Sélectionner ensuite la couche
contenant la ligne de découpe, puis cliquer sur Compute.

S

STONEX

9.13. 3D Perpendicular (PH, S)

The 3D Perpendicular tool enables extending 2D drawings into accurate 3D wireframes. Enable the perpendicular snap
and the Object UCS, then proceed to draw a line starting from the vertex of an existing line. A black symbol will appear to
indicate perpendicularity.

9.14. Clipping with CAD (PH, S)

It is possible to cut out point clouds, meshes and orthophotos using a polygon drawn in CAD as a base. You can either
draw the line in Cube-3D or import one already drawn in other software.

After drawing the line, select the element you wish to crop, right-click and select Clip.

Select the layer where the clipping line is located and click compute
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Cube-3d calcule automatiquement une copie de I'objet, découpée selon les limites de la ligne CAD.
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Page source 109 - résultat de découpe selon une ligne CAD.

10. Présentation du projet (PH, S)

Fonction Recorder
La fonction Recorder permet de créer une présentation vidéo du nuage de points, des mesures et des résultats calculés.

Cliquer sur Recordings dans le viewer. La fenétre Video recorder s’ouvre avec les instructions. Se placer au point de départ
souhaité en faisant tourner, déplacer ou zoomer la vue, puis cliquer sur Add pour créer la premiére caméra d’enregistrement.
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e  Créer plusieurs caméras tout au long du trajet & présenter.

e La trajectoire d’enregistrement apparait entre les positions de caméras sélectionnées.

e  Définir la durée de la vidéo.

e  Utiliser Preview pour prévisualiser le vol et sa durée.

e  Sélectionner une caméra dans la liste pour la supprimer ou la modifier. Modify remplace sa position par le point de vue
courant.

e  Cliquer sur Record lorsque la trajectoire et la durée sont prétes.

S
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10. Project Presentation (PH, S)

Recorder Function

Sometimes you wish to make video presentation of point cloud and measurements made on it. Click Recordings button in
the viewer. A Video recorder with instructions pops up.

As described, you need to rotate/move/zoom to desired start point and click Add button to create first recording camera.
Proceed throe entire area, creating new cameras to capture desired details. A recording trajectory appears between selected
camera positions. Define desired time of recording duration.

Click preview to preview flight and it's duration. By clicking on a camera from list, you can remove or modify it. When you
click modity, cameras position is moved to current viewpoint. Add new ones if pleased. Remember, you will display types
of data and measurements once you record. Once you created desired path of needed duration, click Record.
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Page source 110 - création d’une trajectoire vidéo par positions de caméra.

Dans la fenétre d’export vidéo, définir le chemin, le nom du fichier MP4, la fréquence d’image, le bitrate et I'éventuel filigrane.
Cliquer sur Confirm pour lancer I'enregistrement.
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Pendant le suivi de la trajectoire, il est possible de modifier les données affichées : CAD, Point Cloud, DSM, Profile, Contour lines
ou Volumes. Les options d’affichage permettent de produire un rendu plus démonstratif. Il faut surveiller la barre d’enregistrement
afin que chaque type de donnée reste affiché pendant une durée pertinente.

Fonction Auto Rotate

Le mode Auto Rotate fait tourner automatiquement le modéle 3D tout en conservant le zoom et I'angle de vue.

S
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Video export setting window pops up, where you need to set the path and name of saved recording in mp4 format. Adjust
Frame rate and bitrate if desired. Select weather you want watermark in the recording. Once set, click Confirm to start
recording.

As recording is following desired path, change displayed data by switching between CAD, Point Cloud, DSM, Profile,
Contour lines and Volumes from Working panel. Switch between Viewing options to achieve desired effect. Once you are
viewing point cloud, you can also display it with dsm. When you are viewing dsm, you can display it with point cdoud as
well as drape orthophoto on it. When switching viewed data, observe recording bar, so, that all data is displayed in desired
proportions of time! Once the recording has completed, close Video recording window.

Autorotate Function

The new Auto Rotate mode automatically rotates the 3D model while keeping zoom and viewing angle fixed.
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11. Rapports (PH, S)

Cube-3d permet de générer rapidement un rapport général de projet et/ou un rapport de mesures.

Le rapport général contient les informations sur les images importées ou traitées, le géoréférencement, les positions caméra, les
caractéristiques de vol, la précision calculée, les GCP, les orthophotos, les DSM et le résumé des erreurs.

Le rapport de mesures permet d’inclure les données calculées : profils, volumes, stocks, lignes de profil et courbes de niveau.

11.1. Rapport général (PH)

Pour créer un rapport général, cliquer sur Project -> Generate report -> General report.

Saisir le nom du document et sélectionner les données a inclure. Si aucune sélection spécifique n’est faite, Cube-3d sélectionne
automatiquement les premiers éléments listés dans les onglets du panneau de travail.

Aprés génération, le dossier contenant le rapport s’ouvre automatiquement. Le fichier est généré au format DOCX, ce qui permet
une personnalisation facile. Il peut ensuite étre exporté en PDF depuis I'éditeur de texte.
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5 8 Reports (PH, S)

Generating a general project report and/or measurements report, is basically in a few clicks and the report is done. General
report contains information about imported/processed images, geo-referencing, camera positions, flight characteristics,
calculated accuracy, GCP positions, orthophotos, DSMs, error summary. With measurements report you get the ability to
include all your calculated data, profile lines details, volume and stockpile measurements, and contour lines.

To create a general report, click Project - > Generate report - > General report.

Enter the document’s name and select the data you want included in the report. If not, Cube-3d automatically selects top
listed data from all working panel tabs.

After the report is generated, the folder with report file path pops up for you to verify the information. It is created in *.docx
file which makes it easily customizable. Simply save it as pdf in your text editor if needed.

Here is a quick overview of a general project report.
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11.2. Rapport de mesures (PH, S)
Pour créer un rapport de mesures, cliquer sur Project -> Generate report -> Measurements report.

Saisir le nom du document et choisir les données a inclure. Sans sélection spécifique, Cube-3d sélectionne automatiquement les
premiers éléments disponibles dans les onglets du panneau de travail.

Le rapport est généré au format DOCX, donc modifiable. Il peut étre converti en PDF si nécessaire.
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11.2. Measurement report (PH, S)

To create Measurements report, click Project - > Generate report - > Measurements report.

Enter the document’s name and select the data you want to have included in the report. If not, Cube-3d automatically
selects top listed data from all working panel tabs.

After the report is generated, the folder with report file path pops up for you to verify the information. It is created in *.docx
file which makes it easily customizable. Simply save it as pdf in your text editor if needed.

Here below is a quick overview of a measurements report.
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Page source 114 - génération d’un rapport de mesures.
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Page source 115 - apergu d’un rapport de mesures.

12. Cloud (PH, S)

L’option Cloud est disponible pour les utilisateurs disposant d’'un plan de maintenance de licence actif. Si le plan de maintenance
expire, un renouvellement est nécessaire pour continuer a utiliser la plateforme cloud ; a défaut, le compte cloud est suspendu.

Le cloud inclut 75 Go de stockage en ligne avec une licence active. Si un espace supplémentaire est nécessaire, des extensions
de stockage peuvent étre achetées directement depuis la plateforme.
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L’acces s’effectue via cloud.stonex.it ou directement depuis le logiciel avec le bouton d’upload. Lors du premier acces, I'utilisateur
doit s’enregistrer avec une adresse e-mail valide, son code de licence actif et un mot de passe. Une licence ne peut étre liée qu'a
une seule adresse e-mail ; le changement d’adresse nécessite de contacter le support technique.

STONEX

12. Cloud (PH, S)

The cloud option is available to all users with an active license maintenance plan.

If your maintenance plan expires, you will need to purchase a maintenance renewal to continue using the doud platform.
Otherwise, your cloud account will be suspended

The cloud provides access to 75GB of online storage included with the active license. If you need more storage, you can
purchase additional storage slots. You can request storage expansion directly from the cloud.

you need? Yo

You can also launch the cloud directly from the software using the upload button.

Cube-3d (4.0.7) - New project

The first time you access the platform, you will need to register using a valid email address, your active
license code, and a password. After this initial setup, you will only need your email address and password to
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Page source 116 - accés au cloud, maintenance active et stockage inclus.

12.1. Création de projet
Un nouveau projet peut étre créé depuis la plateforme cloud. Sur la page principale, sélectionner Create New Project et
renseigner les informations demandées.

Il est possible de définir un systéme de référence pour le projet et de préciser la localisation en sélectionnant manuellement
'emplacement sur la carte. Une fois les informations complétées, cliquer sur Create.
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Aprés création, la date de création est visible et une description peut étre ajoutée au projet. Cliquer a nouveau sur Create pour
finaliser la configuration.

S

STONEX

log in again. Each license can be linked to only one email address. If you need to change the associated
email address, please contact technical support.

&°

Sign Up

12.1. Project creation

You can create a new project from the cloud platform.

On the main page, select "Create New Project” and enter the required information. You can also set up a
reference system for the project and specify the project location by manually selecting the location on the
map. Once you're done, select “Create”.

Create new project

Once you've created the project, you can view the creation date and add a description to the project. Click
“Create” to finish setting it up.
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Page source 117 - création d’un projet cloud et définition de la localisation.
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From the software, by selecting “Upload to Cloud,” you can upload data from the 3D cube project directly
to the cloud platform.

On the upload screen, you can select which files to upload to the cloud. Click Next to continue the upload.
Currently, you can upload files from the software:

* Point clouds

#  Mesh

« CADdata

« Orthophotos
*  Profiles

+  Volumes

On the next screen, you can choose whether to upload the data to an existing project or create a new one.

Once you select the project, the software will begin uploading the data to the cloud.
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Page source 118 - finalisation du projet et début de I'envoi depuis Cube-3d.

12.2. Chargement des données depuis le logiciel

Depuis le logiciel, sélectionner Upload to Cloud pour envoyer directement les données du projet Cube-3d vers la plateforme
cloud.

e Nuages de points.
e Maillages.

e Données CAD.

e  Orthophotos.

e  Profils.
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e Volumes.

L’écran d’upload permet de sélectionner les fichiers a envoyer. Cliquer sur Next pour continuer. Il est ensuite possible d’envoyer
les données vers un projet existant ou de créer un nouveau projet. Une fois le projet choisi, 'upload démarre.

12.3. Chargement des données depuis le cloud

Une fois un projet créé, il est aussi possible d’envoyer vers le cloud des données qui ne proviennent pas directement de Cube-3d.
Ouvrir le projet concerné, puis cliquer sur le bouton + en bas a droite.

La page de chargement permet de sélectionner des fichiers ou de les glisser-déposer dans la fenétre. Les types acceptés incluent
notamment orthophotos, nuages de points, maillages, données CAD et vidéos.

S
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Once all the data has been uploaded and the progress bars turn solid blee, click "Done.” The cloud page will
then open automatically.

12.3. Leoading data from the cloud

Once you've created a project, you can also upload other data not included in the 3D cube directly to the
cloud platform.

Open the project you want to work on and select the button in the lower-right corner of the screen with
the “+" symbaol.

A loading page will open automatically. You can select files or drag and drop them directly into the upload
window. You can choose from various types of data in different formats, such as:

# Orthophoto
* Pointclouds
#  Mesh

+ CADdata

*  video

Upload survey files
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Page source 119 - fin d’upload et ajout de données directement depuis le cloud.

12.4. Interface de gestion des projets
L’interface principale permet de visualiser les projets uploadés, de vérifier 'espace de stockage disponible et de créer un nouveau
projet.

Les projets peuvent étre affichés en mode blocs, sur une carte si une localisation a été définie, ou sous forme de chronologie
d’upload.

STONEX

12.4. Project management interface

On the main interface, you can view uploaded projects, check available storage, and create a new project.
You can view the data in different modes. The default view is block-based.

Projects

If the location was specified when the project was created, you can view a map of the uploaded projects.

The last view is by upload timeline.
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Page source 120 - vues bloc, carte et timeline dans l'interface cloud.
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12.5. Interface de projet cloud

Une fois le projet ouvert, I'interface principale est organisée en cinq zones.

Gestion du projet.

Partage des données et gestion du compte.
Viewer principal.

Outils de mesure.

Gestion des données uploadées.

gD~

Gestion du projet

Le bouton Home permet de revenir a I'écran d’accueil du cloud. Le nom du projet affiché en haut de I'écran permet de basculer
vers un autre projet chargé.
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12.5. Cloud project interface

Once the project is open, the main interface is divided into five sections:

Project management

Data Sharing and Account management
Main viewer

Measuring instruments

Management of uploaded data

Lpb il o o o

Project management

Press the Home button to return to the cloud's home screen.

If you select the project name at the top of the screen, you can switch from one loaded project to another
by selecting the name of the new project directly.
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Page source 121 - organisation générale de l'interface de projet cloud.

Partage des données et gestion du compte
L’icone de compte donne accés a la page d’édition du projet ou a la déconnexion. Le bouton Share ouvre la fenétre de partage.

e Lien visible par toute personne disposant du lien.
e Lien visible uniquement par le propriétaire du compte cloud.
e Iframe permettant d'intégrer le résultat dans une page web.

Viewer principal
e Clic gauche + glisser : rotation autour du centre de rotation.

T=CH4 \yAPS

Cube-3d - Manuel utilisateur FR | Source Stonex User Manual Ver. 4.0.1



e Clic droit + glisser : déplacement du nuage selon les axes.

e Molette : zoom avant / arriére.

e Double-clic : zoom sur le point et changement du centre de rotation.
e Bouton inférieur : bascule entre résultats 3D et résultats 2D.

)
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Data Sharing and Account management

By clicking on the account icon, you can go to the project editing page or log out of the online platform.

Clicking the share button will open the share window. You can generate:

+  Ashare link visible to everyone who has the link.
* Asharing link visible only to the cloud account owner.
+ Generate an iframe to embed the result in a web page.

Share project

Main viewer

The main view lets you browse the cloud and the various results that have been uploaded. To navigate the
viewer:

+  Left-click + drag: Rotates the cloud around the center of rotation.
# Right-click + drag: mowves the cloud along the axes.

+  Mouse wheel: zoom in and out.

* Double-click: zoom in on the point and change the rotation center.

You can switch from 3D results to 2D results using the button at the bottom.
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Page source 122 - partage, navigation viewer et bascule 2D/3D.

Outils de mesure

Les boutons latéraux permettent de mesurer distances et surfaces, de dessiner des polygones et cercles, et d’ajouter des
annotations.

e  Fléche de sélection.
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e Dessin de point.

e Dessin de ligne.

e Dessin de hauteur.
e Dessin de cercle.

e Dessin de polygone.
e Annotation.

Aprés création d’une entité ou d’'une annotation, la sélection affiche ses propriétés a droite de I'interface. Il est possible de
modifier la couleur, la couche CAD, de consulter les informations de synthése et de supprimer I'entité avec l'icbne corbeille.

S

STONEX
Using the side icons, you can, respectively:
e Save ascreenshot of the main view. @
¢ Zoom out to the full extent of the cloud. (e
e Zoomin. o
e Zoom out. Q

Measuring instruments

Using the side buttons, you can measure distances and areas. You can draw polygons and circles. You can
also add annotations.

e Selection arrow.
e Draw point.
e Draw line.
e Draw height.
e Drawcircle.
e Draw polygon.
* Annotation.
After drawing an entity or creating an annotation, you can select it to view the properties of the newly

drawn entity on the right side of the interface. You can change its color and CAD layer and view its
summary information. You can also delete the entity using the button with the trash can icon.
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Page source 123 - outils de mesure et propriétés des entités cloud.
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Gestion des données uploadées
En bas a droite, I'utilisateur visualise les données uploadées et choisit les éléments a afficher dans la vue principale.

Les types de données disponibles dépendent du mode d’affichage. Les orthophotos sont visibles en vue 2D ; les nuages et
maillages sont visibles en vue 3D.

Le bouton + permet de créer de nouvelles couches CAD ou d'importer des données extérieures au projet. La corbeille permet de
supprimer un enregistrement. Le bouton en forme de molette, en bas a gauche, ouvre I'éditeur de projet.

12.6. Comparaison temporelle basée sur le modele

Dans un méme projet, il est possible de créer plusieurs relevés réalisés a des dates différentes. Aller dans I'éditeur de projet, puis
cliquer sur Add New Survey.

Une fois le projet ouvert, il est possible de basculer entre les relevés en changeant le relevé de référence en haut de I'écran.

T=CH4 \yAPS

Cube-3d - Manuel utilisateur FR | Source Stonex User Manual Ver. 4.0.1



)

STONEX

Management of uploaded data

In the bottom-right corner of the interface, you can view the uploaded data and choose what to display in
the main view.

Depending on the view mode (2D/30), different types of data are displayed. For example, orthophotos are
anly visible in 20 view. Similarly, clouds and meshes are anly visible in 30 view.

You can also create new CAD layers using the plus button or use the same button to import data from
outside the project.

You can delete a record using the trash can button.

Using the scroll wheel button in the lower-left corner, you can open the project editor.

126, Mode d time series comparisor

Within the same project, you can create multiple surveys conducted at different times. To do this, go to the
project editor page and click “Add New Survey™.

Onece the project is open, you can switch between surveys by changing the reference survey at the top.
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Page source 124 - données uploadées et ajout d’'un nouveau relevé temporel.

Les données issues de plusieurs relevés peuvent étre affichées simultanément, a condition qu’elles soient géoréférencées dans
le méme systéme de coordonnées.

Sur I'écran principal, utiliser le bouton de split-screen. Les deux relevés s’affichent superposés. Le curseur central permet
d’ajuster la visualisation entre les relevés. Les icbnes latérales permettent de changer les types de données affichées.

Un autre mode affiche les deux jeux de données dans deux vues séparées tout en conservant la méme perspective pendant la
navigation.
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You can also view the uploaded data from different surveys at the same time. Both surveys must be
georeferenced to the same coordinate system.

On the main screen, tap the split-screen button.

The data from the two surveys will be displayed overlaid on top of each other. You can adjust the view by
moving the central slider to display the different surveys. By tapping the two side icons, you can also
change the types of data displayed on the screen.

You can switch to a different view of the data by clicking the button:

In this view, you will see the data in two different views, while maintaining the same perspective as you
navigate.
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Page source 125 - comparaison split-screen entre deux relevés géoréférencés.

Si plusieurs profils ont été chargés, ils peuvent étre affichés ensemble dans la vue Profile. Double-cliquer sur le nom du profil
souhaité pour I'ouvrir en bas du viewer, comparer les profils et calculer les différences d’altitude.

Les profils a afficher peuvent aussi étre sélectionnés directement dans le cloud en double-cliquant sur la ligne concernée.
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If you have loaded multiple profiles, you can view them all at once on the profile view screen.

When you double-click the name of the desired profile, the profiles will open at the bottom of the viewer,
where you can compare them and calculate the differences in their elevations.

You can also select the profiles you want to view directly in the cloud by double-clicking on the row of
interest.
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